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1 Introducing LightningFAX

Who Should Read This Manual

This manual is intended for any one using LightningFAX to send, 
receive, and manage faxes. It does not cover LightningFAX installation 
and configuration, or the creation and management of users and user 
groups. Those topics are covered in the LightningFAX administrator 
and Installation Guide.

An Overview of the Manual

Chapter 2 Getting Started provides a hands-on introduction to several 
common-place LightningFAX and SendFAX operations.

Chapter 3 Introducing the Manager details fax management and other 
operations using the LightningFAX manager.

Chapter 4 Fax Details Information details the information about 
incoming and outgoing faxes available to LightningFAX users.

Chapter 5 Managing User Properties details the user properties you 
can modify.

Chapter 6 Introducing SendFAX details how faxes are sent using 
SendFAX. Also outlined is including a profile and a cover sheet, how to 
use advanced transmission settings, and how to access a phone book.

Chapter 7 Fax Utilities in LightningFAX details using the various 
faxing interfaces and utilities available in the LightningFAX client is 
installed. It describes faxing from Windows applications, faxing using 
Microsoft Word’s Mail Merge feature, emailing faxes, etc.

Chapter 8 Introducing Phone Books details how phone books are 
created and maintained, how to add contacts, contact lists, and groups 
of potential fax recipients.

Chapter 9 Introducing the Viewer details how to use the Viewer to 
search for and view faxes, how to manage the Viewer itself, and 
outlines how to add annotations to the faxes you have received.
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Chapter 10 Introducing the Cover Sheet Editor details how the cover 
sheet editor can be used to generate cover sheets used when faxing 
with SendFAX.

Chapter 11 Introducing Profiles details LightningFAX profiles, which 
provide a means of managing your sender information in a variety of 
ways.

Chapter 12 About Annotations details the annotations available in 
both SendFAX and the viewer and the methods of adding them to faxes 
you send and faxes you have received.

Chapter 13 Introducing Fax Headers details what fax headers are and 
how to compose them.

Chapter 14 Introducing LightningFAX Mail Gateways details faxing 
through the mail gateways, that is, your email software. It also details 
creating distribution lists for fax broadcasts from your email program 
and how to use body codes in your message.

Chapter 15 Introducing the Forms for Microsoft Outlook details how 
to send faxes if you have installed the Forms for Microsoft Outlook, an 
interface that provides more extensive functionality than the gateway 
for Microsoft Exchange.

Chapter 16 Introducing the Forms for Lotus Notes details how to 
send faxes if you have installed the Forms for Lotus Notes.

The LightningFAX Client

The principal components of the LightningFAX client are:

LightningFAX Manager

To the user, the manager provides the means to handle their incoming, 
outgoing and archived faxes, as well as to configure their user 
properties. For example, users can search for, view, print, delete, or 
archive faxes sent and received; forward or copy faxes to others in the 
LightningFAX network; and modify notification or printing options.

Note: Administrators can restrict changes that users can make to their 
settings.

SendFAX

SendFAX is the program used to compose, address, and send faxes. 
SendFAX also provides a means of entering fax sender and fax 
recipient information and changing transmission settings.

Faxes can be sent to numeric as well as email addresses.

Note: LightningFAX functionality can be installed so that end users fax 
strictly through their email software. When this is the case; faxes, 
both incoming and outgoing, are managed through such programs 
as Microsoft Outlook, Lotus Notes, or Netscape Communicator, 
exactly as email messages are. Further, the LightningFAX 
manager, SendFAX, and the tools and utilities that come with 
them, are not available.
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LightningFAX Tools

LightningFAX tools include the following.

Cover Sheet Editor

Administrators and users use the cover sheet editor to compose fax 
cover sheets to be used when faxing with SendFAX. A selection of 
preformatted cover sheets is provided. Variables that are resolved 
when the fax is sent can be added to any cover sheet to include such 
information as sender name, company name and address, telephone 
and fax numbers, etc.

By default, the cover sheet editor is not installed with the 
LightningFAX client. It is possible therefore that some users will not 
have access to it.

Private Phone Book

The private phone book allows a user to organize and group fax 
recipients for easy selection in SendFAX. Any number of phone books 
can be created. Administrators can make a public phone book available 
to a group of LightningFAX users; however, the public phone book is a 
custom component that is not included with a LightningFAX client 
installation.

The Viewer

The viewer allows users to display, read, and annotate faxes. In 
addition, users can rearrange fax pages to generate another fax. The 
viewer can be freely emailed to potential fax recipients.

Each tool is accessible through LightningFAX manager, SendFAX, and 
as a separate Start menu selection.

LightningFAX Printer Driver

The printer driver is automatically added to the list of available 
printers during Client installation. Users can send faxes from 
third-party applications Like Word, WordPerfect, Excel or Quattro 
Pro, etc., by selecting the LightningFAX printer driver after using the 
application's Print command. Executing the Print command launches 
SendFAX with the document included as a fax. The fax can then be 
addressed and sent.

LightningFAX Profiles

A profile can contain a fax header, reference a cover sheet, and store 
information about the fax sender. If one is available, a user can select a 
profile when faxing from SendFAX.

Profiles address several needs. For example, several profiles might 
each reference different cover sheets, each cover sheet written in a 
different language. Two or more profiles, each with different sender 
information, allow users to send faxes on behalf of others. Profiles also 
allow administrators to specify a common fax header and to enter 
company information once for a large number of users.
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Once composed and saved, profiles can be applied both through 
SendFAX and Forms for Microsoft Outlook.

Although profiles are often created by administrators, users can create, 
manage, and use their own profiles.

LightningFAX PrintToMail Printer Driver

The LightningFAX PrintToMail printer driver provides a means of 
emailing a file from a third-party application. When writing a 
document in a third-party application such as Word or WordPerfect, 
the user prints and selects the PrintToMail printer. When the print 
operation is executed, the user's default email software is launched 
with the document attached as a TIFF fax image file. The user can then 
address and send the file as they would any other email message.

The recipient requires an appropriate TIFF viewer.

Mail Merge for Microsoft Word

Mail Merge for Microsoft Word allows users to use Word to generate a 
Main Document and a Data Source and then fax to all recipients 
recorded in the Data Source.

When installed, Mail Merge for Microsoft Word adds a macro and a 
LightningFAX toolbar. Those additions aside, composing the Main 
Document and the Data Source remain much as they are in Word.

However, Mail Merge for Word uses four merge fields: First Name, 
Last Name, Company, and Fax Number, which are mapped to the Word 
merge fields selected when writing the Main Document.

Additional Faxing Interfaces

LightningFAX also offers other faxing interfaces. These include the 
LightningFAX gateways for email software and for the Hewlett Packard 
Digital Sender.

LightningFAX Gateways

If installed, a gateway provides a means of sending, receiving, and 
managing faxes through your email software. These are the gateways 
that can be installed on your computer.

Generally, a gateway is installed as an alternative to the full 
LightningFAX client. It provides the means to send and receive faxes 
without the need to install, or to learn, the full LightningFAX client.

❑ Gateway for Microsoft 
Exchange

❑ Gateway for Simple Mail 
Transfer Protocol (SMTP)

❑ Gateway for R/3
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LightningFAX Scanner Service

The scanner service for the Hewlett Packard 9100C Digital Sender 
faxes TIFF files generated by the Hewlett Packard Digital Sender. The 
fax operation takes place through the Digital Sender's interface.

The scanner service is a custom installation.

LightningFAX User Status

There are three LightningFAX user status.

❑ Administrator

Administrators can configure LightningFAX, create and manage users 
and user groups, manage faxes; in short, execute any operation 
LightningFAX performs.

❑ Super User

Super users have the right to access the faxes received and route them 
to the proper recipient in the LightningFAX network. Unless an 
administrator gives them greater privileges, they can see only the 
cover sheet of the faxes they direct to others.

Note: If a Super User can only view the cover sheet of a fax, he/she 
will not be able to save the fax to the server.

❑ User

Users have the rights assigned them by an administrator. Aside from 
sending and managing their own faxes, they may be able to route faxes 
to members of the LightningFAX network.

LightningFAX Groups

Groups are a means of organizing users. An administrator can make 
you a member of one or more groups. If you are a member of a group, 
you enjoy the settings assigned to that group, in addition to your user 
privileges. Group membership is not mandatory. An administrator 
might deliberately choose not to enroll some LightningFAX users in 
any group.

You can also be a guest in a group. Like primary group members, you 
will be able to access the group’s incoming faxes. However, group 
settings are not applied to you. For example, an administrator may 
establish one set of archiving, printing, and notify options for a group 
and a different set for you. If you are a guest in the group, your user 
options, not the group’s, apply.



Chapter 1 Introducing LightningFAX

6 LightningFAX User Guide

Users and LightningFAX Resources

A standard resource basically represents a grouping of fax channels 
(inbound and outbound). All channels in a resource share the same 
transmission parameters, such as CSID, number of retries, etc... It is 
however possible to override these parameters with individual user 
settings, if need be.

A resource is a repository for all the faxes sent or received on its 
channels. Each resource also has the potential to have its own routing 
table.

A resource is linked to only one driver, but a driver can connect to 
multiple resources (based on channel mapping).

Users are assigned access rights to a resource, which then lets them 
send and receive faxes through its channels. A user with access to 
multiple resources can thus have different personalized settings for 
each resource.

After initial installation to the Microsoft Windows operating system, 
the LightningFAX manager displays three resources in the tree view.

By default, Resource 1 is associated with all LightningFAX channels. 
It is Resource 1 that actually transmits incoming and outgoing faxes. 
The Common Resource and All Resources, which cannot be 
associated with LightningFAX channels, are folders through which 
users access faxes.

The Common Resource is the bridge between all resources. Any 
communication between two resources must be done through the 
Common Resource.

It displays faxes forwarded or copied by other members of the 
LightningFAX network. All users have implicit access to this resource.

All Resources allows users to view simultaneously both incoming 
and outgoing faxes. For example, an administrator configures 
Resource 1 to transmit outgoing faxes. A second resource, 
Resource 2, is specified and configured to transmit incoming faxes. 
Finally, a user is given access to both resources. Only the user's 
outgoing faxes are displayed under Resource 1; the user's incoming 
faxes are displayed under Resource 2. By going to All Resources, 
the user can display both incoming and outgoing faxes at once.

All Resources has no configurable properties.

Note: Only LightningFAX administrators can access and modify 
resource properties.

Common Resource Resource 1 All Resources
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2 Getting Started

This chapter introduces some of the basic features of the manager, 
SendFAX, the phone book and profiles.

Users must of course log on, whether under their Windows domain 
account or under their LightningFAX account, before they can access 
LightningFAX.

Logging on to LightningFAX

To log on to the manager:

❑ Choose Start ➡ Programs ➡ LightningFAX ➡ LightningFAX 
Manager.

If you are logging on for the first time, the logon dialog box appears.

Note: The log on procedures described here also apply when you launch 
SendFAX from the Windows Start menu. 

Logging on to a Windows NT Domain

Your exact log on depends on how your administrator configured the 
network. If LightningFAX was configured to make use of a Windows 
NT domain and includes the users in that domain, your logon window 
will match the following illustration.  

❑ Click OK. You need not enter a password.
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Logging on using LightningFAX Authentication

If you have a LightningFAX account, you log on using LightningFAX 
authentication, that is, using the User ID and password of your 
LightningFAX account. The following logon dialog box is displayed. 

1 Enter the LightningFAX user ID.

2 If you were assigned a password, enter it in the Password field.

3 Click OK.

Note: The LightningFAX server is usually configured to use port 7007. If 
your administrator used a different port, you must use the 
following syntax in the LightningFAX manager logon dialog box.

server:port

where server is the IP address or DNS or WINS name of the 
LightningFAX server and port is the port the administrator 
specified during installation.

Choosing your Logon Format

When you have a LightningFAX account and a Windows NT domain 
account, you can choose either logon format.

To select either LightningFAX authentication or a Windows NT 
domain at log on:

1 Click the pop-up menu beside the User ID field. 
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2 Select your logon format.

When LightningFAX is installed on more than one server machine, you 
can select the server you want by using Server to display the list of 
servers available to you.

You can enter a server name in this field if you wish. LightningFAX 
displays an error message if you enter an invalid server name.

After you log on, the manager is displayed. 

Introducing SendFAX

Among the other activities available, you certainly send faxes.

You can access SendFAX through:

❑ Tools ➡ SendFAX in the manager window

❑ Start ➡ Programs ➡ LightningFAX ➡ SendFAX
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The SendFAX window is displayed after you log on. 

If this is your first time using SendFAX, one of the first things you 
might wish to do is to populate a telephone book with potential fax 
recipients. A phone book allows you to select fax recipients rather than 
manually address your faxes.

Choose Tools ➡ LightningFAX Phone Book. 

LightningFAX offers a default phone book that contains information 
about the people you often send faxes to. We’ll assume you decided to 
create a new one.
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Phone books are organized in the following hierarchy.

❑ A phone book, a user can make any number of phone books

❑ A contact list, several contact lists can exist in a phone book

❑ A group, contacts can be grouped, faxes sent to the group are sent to all 
members of the group

❑ the contacts themselves

Let’s say that you need only a single contact list. A default contact list 
named Contact already exists and you’ll put the new contact there.

Ungrouped Contacts

Choose File ➡ New ➡ Contact from the phone book menu.

The contact information is much as you’d expect: a name and job title, 
company information, and contact numbers. However, some fields are 
worth special attention.

The Fax and E-mail fields allow you to make three different entries. If 
your recipient travels frequently, you might wish to enter their home 
office as the first fax number, an office they visit often as the second, 
and perhaps their home fax number as a third. The same applies to 
your recipient’s e-mail addresses.

When you do enter several fax numbers or e-mail addresses, the 
Preferred Address drop-down list becomes important. When you 
select a fax recipient from the phone book in SendFAX, the fax number 
or e-mail address shown in Preferred Address is the destination the 
fax is sent to.

Note: When you fax to an e-mail address, you instruct SendFAX to 
e-mail the fax message. A gateway must be installed in your 
network to deliver the e-mail. Your fax is received as an e-mail 
attachment.
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Billing Information offers two fields: Billing Code and 
Sub-Billing Code. Here, you can enter a number that identifies your 
recipient or their company for billing purposes. For example, a law 
firm communicating by long distance to a client might bill the 
telephone charges to the client and subsequently assign a billing code 
to that client. That code would be entered here.

Two billing fields allow for greater precision. Although a small 
business might require a single billing code; a larger one might find it 
necessary to use one billing code to identify the firm and a sub-billing 
code to identify a particular department or office.

Click OK when you have entered all the contact information.

Grouping Contacts

Creating groups of contacts allows you to select the group in SendFAX 
and fax to every member of the group.

Choose File ➡ New ➡ Group from phone book menu and enter a name 
in the Name field.

To enter a contact, click Add New. The Contact Properties window is 
displayed and you can enter contact information just as you did for an 
ungrouped contact.

Click OK in the Group Properties window when you have entered all 
members.
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Displaying a Phone Book

By default, the SendFAX interface does not display a contact list from a 
phone book. If you have a phone book, and if your administrator has 
created a public phone book, you certainly want to display it when 
you’re using SendFAX.

To display a phone book in SendFAX, choose View ➡ Phone Book ➡ 
Show Right or View ➡ Phone Book ➡ Show Left.

The following illustration shows SendFAX with a contact list from the 
phone book displayed on the right. 

See Chapter 8 Introducing Phone Books to learn more.

Choosing a Cover Sheet

LightningFAX makes several cover sheets available and, if it’s installed 
on your system, you can use the cover sheet editor to create your own 
cover sheets.

Assuming that you’ll begin with the pre-configured cover sheets, use 
the following steps to select one.

Use No Cover Sheet to select the cover sheet you want. 



Chapter 2 Getting Started

14 LightningFAX User Guide

You might first select a cover sheet by using the pull-down list 
available in the No Cover Sheet pull-down list and selecting More 
Local. A list of available cover sheets is displayed. A preview of each 
cover sheet is displayed when a sheet is selected.

Assuming you pick Basic01.cse, SendFAX displays that cover sheet in 
the thumbnail (left-hand) and the fax preview panes. 

A cover sheet will remain selected until you cancel it by selecting No 
Cover Sheet or choosing another.

See Chapter 10 Introducing the Cover Sheet Editor for more 
information.

Your Profiles

A profile can store your personal information: your name, your contact 
numbers and e-mail address, and your company information. 
However, you can use profiles for several other purposes. Because 
profiles can reference a cover page; you can create two cover sheets, 
each containing the same information in different languages. You 
would then create a profile, each referencing one of the cover sheets. 
In SendFAX, you’d select one or the other profile, depending on which 
cover sheet you wanted to use.

Another use for profiles is to fax on behalf of others. After all, you 
don’t have to enter your own name. You can create a profile that 
contains the personal information of a colleague and then use that 
profile when the colleague is on vacation or a business trip.
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To create a profile, choose Tools ➡Profile Management and click New.

Enter a name and click OK.

Like phone books, a profile contains the fields you would expect. And, 
again, some fields and options are worth extra attention.

LightningFAX resources are folders where faxes are stored and users 
can be associated with more than one resource. If your administrator 
has given you access to several, you can use Resource to select one in 
the profile. Whenever you send a fax using that profile, LightningFAX 
will store a copy of the outgoing fax under your name on the resource 
the profile references. You might prefer to use a different resource 
when you know the resource you usually use is being heavily used by 
other SendFAX users.
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Least cost routing (LCR) is a means of reducing or even avoiding long 
distance telephone charges. Your administrator might configure LCR 
when there are two or more LightningFAX servers in a local or wide 
area network.

For example, a company has a LightningFAX server in its offices in 
New York, Paris, and Rome. Let’s say that a client of the New York 
office is located in London. An employee in the New York office could 
send a fax directly to the client, and pay the long-distance telephone 
charges. Alternatively, they could use LCR to send the fax to the office 
in Paris and let that office send the fax to its final destination by 
telephone. Because a LightningFAX server uses the TCP/IP protocol to 
communicate with an other LightningFAX server, the fax travels from 
New York to Paris using TCP/IP. In other words, the company avoids a 
transatlantic telephone call.

Of course, least cost routing doesn’t just happen. Your administrator 
has to configure it and you must instruct SendFAX to use it. By 
creating a profile and selecting the Use LCR option, you can make LCR 
selection in SendFAX automatic. Just use that profile whenever your 
fax is to be sent using least cost routing.

Finally, there’s your sender billing information. Your fax might 
represent a purchase order and you might wish to inform the recipient 
of the billing code your company expects on the invoices it receives. 
The Sub-Billing Code field allows for greater detail. For example, 
your company might have a billing code for orders and sub-billing 
codes that identify the product or services being ordered.

Note: Although other components in LightningFAX allow you enter the 
information while you are faxing, a profile is the only place where 
you can permanently store sender billing information.

Click OK when you finished entering your profile information.

Now that you have a profile, you want to reference it in SendFAX. Use 
Profile to select any of the profiles you create.

See Chapter 11 Introducing Profiles for more information.

Addressing a Fax

The simplest way to address a fax is to select a recipient or group from 

the phone book’s contact list and click .
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That action copies the name or group to the list of fax recipients.

Of course, you can also make direct entries to the To, Company, and 
Destination fields. To receives the recipient’s name and 
Destination receives the recipient’s fax number or e-mail address.

After making entries to these fields, click  to move the information 
to the list of fax recipients.

Next, of course, is information you want to send.

Choose File ➡ Insert or click  and then navigate to the file to be 
sent. If the file is on the desktop, you can drag-and-drop the file into 
the thumbnail view. You can add as many documents as you wish.

Finally, click Send.

Routing Faxes

Routing faxes that have been received by the Default Recipient to 
the individual to receive them is the main function of a Super User, a 
status your administrator might give you.

In this example, C Delaney is the Super User tasked with routing 
incoming faxes from the Default Recipient to those who must 
receive them. Three users, P Martin, D Smith, and F Jones, have 
received faxes.

C Delaney is already logged on to LightningFAX and notices that 
incoming faxes have arrived on Resource 2, which is configured to 
receive faxes. 
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Clicking the first and automatically opening the viewer to inspect the 
cover page, C Delaney learns that this fax is sent to F Jones. Closing 
the view, C Delaney highlights the fax and right-clicks it. 

C Delaney selects Route in the pop-up menu.

Knowing that F Jones works in the Accounting department, C Delaney 
uses the pull-down menus to choose the Accounting Group and the 
user F Jones and clicks Route.
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The fax is immediately routed to F Jones and C Delaney continues with 
the next fax received. 

At a client workstation in LightningFAX network, F Jones launches the 
LightningFAX Manager finds a fax waiting to be opened and read. 

Further details on routing and fax management can be found in 
Chapter 3 Introducing the Manager.
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3 Introducing the Manager

The manager provides access to your incoming, outgoing, and archived 
faxes in a tree structure similar to Windows Explorer. You can view, 
delete, and archive the faxes you are authorized to view. You can also 
route and copy them to other members of your network.

You can also set your user preferences; instruct LightningFAX to notify 
you when certain faxing events occur; specify how frequently 
LightningFAX is to check for newly received faxes; and, if you have 
access to a gateway, set user notification for faxes sent and received 
through your e-mail software.

When you log on to the LightningFAX network with your user ID from 
any workstation connected to the LightningFAX network, your 
personal default settings are used. You can log on to LightningFAX 
using either LightningFAX authentication or your Windows NT 
domain account.

Launching the Manager

To launch the manager:

1 Choose Start ➡ Programs ➡ LightningFAX ➡ LightningFAX 
Manager.

2 Enter your log on information and password.

Note: When logging into the fax manager or the web client as an LDAP 
user, a password is mandatory. Trying to login with a blank 
password fails. Other types of users are logged in as anonymous 
users, when the password is left blank.

After you log on, the manager appears, listing your faxes. Faxes can be 
selected by highlighting them. Several or all faxes can be selected by 
holding the Shift key while highlighting them
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. 

The administrator can assign you a restricted or an unrestricted view 
of the LightningFAX network. The restricted view shows your user ID 
and three branches: incoming faxes, outgoing faxes, and archived 
faxes.

The unrestricted view displays the entire network. Assuming you have 
expanded the tree to find your user ID, the unrestricted view might 
resemble the following illustration. 

This view lists other users and groups as well as the resources with 
which users are associated. You are not able to view other users’ faxes 
unless you have Administrator status. Whatever your status, you can 
use drag-and-drop to copy your faxes to other members of the network.

Tree View Fax List
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Faxes are transmitted to you in one of three different manners.

❑ Faxes transmitted to you by telephone are received by the resource 
with which you are associated and are routed to you by a user with 
Administrator or Super User privileges. You access these faxes by 
locating your user ID under Common Resources ➡ All Users or under 
All Resources ➡ All Users.

❑ If your administrator has enabled Direct Inward Dialing (DID) for you, 
these faxes are received directly by the resource with which you are 
associated.

❑ Other members of the network can route or copy their faxes to you. 
Again, you can access these by locating your user ID under Common 
Resources ➡ All Users or All Resources ➡ All Users.

Whichever the view, click the category in the tree to display only the 
faxes in that category in the fax list view. 

Note: Your administrator can select one or another of these categories 
for your default fax list view. For example, if incoming faxes is 
your default fax list view, only incoming faxes are displayed in the 
manager when you log on. You must highlight another category in 
the tree view to see the faxes in that category in the fax list view.

The administrator can also decide what status of fax is displayed 
in the fax list view. For example, an administrator can specify that 
your outgoing failed faxes are not listed immediately at log on, but 
only when you highlight Outgoing in the tree view. Whether 
incoming or outgoing, faxes can be current or archived. Current 
faxes are those you have neither deleted nor archived.

Faxes can be archived only if you, or an administrator, enable the 
archiving options in your User Properties. The faxes you delete from 
the incoming or outgoing views are moved to the archive view. If 
archiving is not enabled, the faxes you delete are simply removed.

Archived faxes are removed by the same delete operation. However, an 
administrator must grant you the right to delete archived faxes.

Incoming Faxes Outgoing Faxes Archived Faxes
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Fax List Display

By default, the Fax List displays fax information in seven columns: 
Info, First Name, Last Name, Submitted/Received Time, 
Completed/Acknowledged Time, Company, and Subject. However, 
you can adjust the column headings to display any information 
available in Fax Details.

By default, faxes in the fax list are sorted on Submitted/Received Time 
in descending order. The most recent faxes appear first. If you wish 
you can select any column heading as the sort key and choose either 
ascending or descending sort order.

the fax’s status as an icon

the fax recipient’s first name (this field is blank in faxes you receive)

the fax recipient’s last name (this field is blank in faxes you receive)

the date and time you submitted or received the fax

the date and time your fax transmission was completed or when your 
system acknowledged receiving a fax

the company name, if one was specified

the subject, if one was specified

the fax’s status as text

You can change the column headings if you wish by (a) deleting a 
column heading, (b) changing a column heading for another, and (c) 
inserting a new column heading.
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Incoming and Outgoing Fax Status

An incoming or outgoing fax has a specific status dictated by the stage 
in processing.

Note: Messages delivered or received through an email gateway use the 
same icons to indicate their status. However, not all status are 
applied.

Your default tree view might not display incoming faxes with a 
status of Processed or Rejected.

Status begun with the letters LCR refer to least cost routing and load 
balancing, a means of sending faxes over the Internet to reduce long 
distance charges. Your network may or may not be using least cost 
routing.

It may not be necessary to add that selecting a fax status with the 
cursor displays the faxes with that status in the fax list.

Faxes can be sent to one or several recipients. When sent to two or 
more recipients, they are called broadcast faxes.

An icon in the shape of a page identifies both kinds of transmissions. 
However, the icon identifying a broadcast fax has multiple pages and is 
turquoise.

A fax being transmitted to a single recipient has the status Sending, 
and if it is successful, has a green check-mark beside it and its status is 
Sent.

Incoming Fax Status Outgoing Fax Status

Legend
Waiting for Retry is red.
Ready to Send is Green.
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A broadcast being transmitted has the status Processing, and if it is 
successful, receives a green check-mark beside its icon and its status is 
changed to Processed.

The File Menu

Login allows you to log on to LightningFAX and to select any valid fax 
server in the network.

Change Password lets you change your LightningFAX user password, if 
your administrator assigned one. A window prompts you for your 
current password, the new password, and a confirmation of the new 
password.

Exit closes the manager.

The Edit Menu

Properties displays a window with a series of tabs in which you can 
specify the following information.

Broadcast Faxes

Information Specifies sender information, that is, information such 
as your first and last names, a salutation, your company 
name, etc.

This information is automatically passed to the 
corresponding variables in the fax cover sheets that 
introduce your faxes.

Routing Forwards faxes automatically to another user in the 
LightningFAX network.

If your administrator has given you the rights, you can 
also specify a Direct Inward Dialing (DID) number and 
enter a printer ID number.

User 
Settings

Specifies your archiving, printing, deleting, and 
notification
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The Properties menu selection is available only when your user ID is 
highlighted in the network view.

Note: The administrator can specify all of the above information for you. 
However, you can override most of these settings using the 
Properties menu selection.
However, the administrator can set your archiving options and 
your printer ID; and enter your CSID, callback number, number of 
retries, fax header, suffix, and prefix; and prevent you from 
changing them.

The View Menu

Search looks for a text string in all the faxes listed, including 
broadcasts. You can filter the search by current and archived faxes, 
specify that only faxes of a certain status be searched, and specify a 
date or period of time.

If you select Search in a broadcast list, the search is only executed on 
the faxes within the broadcast itself.

Frequency Specifies how frequently LightningFAX is to poll the 
server to learn if you have new faxes and the rate at 
which you are notified of events like fax receipt or 
transmission failure.

Fax Settings Specifies your Call Station Identification (CSID), a 
callback number, number of retries, suffix and prefix, 
and a fax header.

Preferences Alters the tree view presented by the manager. The 
default restricted view of the LightningFAX network has 
already been illustrated. The unrestricted view is 
detailed later in this chapter.

Users with Super User status can select either view, and 
specify whether other users should be displayed in the 
tree view.

E-Mail Specifies your preferences for notification if you use 
your email program to send faxes.

One of the LightningFAX gateways must be installed in 
your network if specifications in this tab are to be 
functional. This tab does not appear if no gateway is 
installed.
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The Fax Menu

View opens the highlighted fax in the viewer.

Print Faxes print the highlighted fax.

Edit lets you edit or enter information about the recipient of the 
highlighted fax. 

Show Details displays detailed information the highlighted fax.

Print Details prints the same information.

Reroute is only enabled for administrators. It takes a received fax and 
re-runs it automatically through the routing process.

Route redirects highlighted faxes to a single recipient in the network.

Copy copies the highlighted fax to one or more recipients in the 
network.

Resubmit resubmits failed, paused, or previously sent faxes. You can 
resubmit the fax immediately by choosing Resubmit ➡ Now or schedule 
transmission for a later time by choosing Resubmit ➡ Later.

Send To ➡ Mail Recipient launches your e-mail program. The 
highlighted fax is included as an attachment. Send To ➡ SendFAX 
launches SendFAX with the highlighting fax already inserted.

Pause suspends transmission of the highlighted fax. It can be applied 
to any fax whose status is Ready to Send, Waiting for Retry or 
Postponed. Resubmit resumes transmission.

Stop Transmission terminates transmission of the highlighted fax, 
setting the status to Failed. It can be applied to any fax whose status 
is Sending.  LightningFAX finishes the page in transmission before 
stopping transmission. You can use the Resubmit menu selection to 
resubmit a failed fax.

Delete removes all highlighted faxes. If you or your administrator 
have enabled archiving, deleted faxes are moved from the current list 
to the archive.

Select All highlights all faxes.

Unselect All clears all highlighting of selected faxes.

Send List To sends the fax list to a file or to a printer. The list is 
ordered in columns, the labels are used as column headings.
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The Tools Menu

SendFAX launches SendFAX.

PhoneBook launches the phone book. See Chapter 8 Introducing Phone 
Books for details.

Cover Sheet Editor launches the cover sheet editor. See Chapter 10 
Introducing the Cover Sheet Editor for details.

Viewer launches the viewer. See Chapter 9 Introducing the Viewer for 
details.

Profile Management opens the Profile Management window. See 
Chapter 11 Introducing Profiles for details.

The Refresh Menu

Refresh updates the LightningFAX window, instructing LightningFAX 
to search the server for any new faxes. The time shown on the status 
bar is also updated.

LightningFAX Manager Pop-up Menus

Pop-up menus, displayed when you select your user ID, a fax, or a 
broadcast fax in the fax list view offer most of the menu selections 
described above. Only the additional selections these pop-up menus 
make available are described here.

User ID Pop-Up Menu:The following menu becomes available when 
you right-click after highlighting your user ID. 
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Fax Pop-Up Menu:The following menu becomes available when you 
right-click in the fax list view after highlighting a fax sent to a single 
recipient.

Send List To displays a sub-menu through which you send the list to a 
file or a printer.

If you select File, you can enter a file name or click Browse to 
navigate to an existing file that you intend to overwrite. A check box 
allows you to include the labels of the fax view list as column headings. 
A second check box specifies that all faxes included in a broadcast be 
written to the file. Although available when any fax is highlighted, this 
check box is functional only when a broadcast fax is highlighted.

Two radio buttons allow you to include all faxes in the list or only 
selected ones.

If you select Printer, you send the fax list to the printer. One, several, 
or all faxes can be selected and you can select the printer if several are 
available.
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Broadcast Fax Pop-Up Menu: The following pop-up menu becomes 
available when you right-click in the fax list view after highlighting a 
broadcast fax.

Explore modifies both the network and the fax list view to display the 
faxes in the broadcast. 

You select any faxes included in the broadcast as you would any fax 
listed in the fax list view. The same menu selections and operations are 
available.

Click  to return to the default view.

Column-Headings Pop-up Menu When you place the cursor over the 
column headings and right-click, the Column-Headings pop-up menu 
is displayed. This menu allows you:

❑ to delete the column heading below the cursor

❑ to select a different column heading to replace the column heading 
below the cursor

❑ to insert a new column heading immediately after the column heading 
below the cursor

Whether you choose Change The Column For or Insert After The 
Column, the following submenu selections are available.
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Only summarized here, the definitions of the values these column 
headings represent can be found in Chapter 4 Fax Details Information.
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Edit Fax Information

1 In the manager, select the fax in the fax list.

2 Choose Fax ➡ Edit or right-click and choose Edit.

3 You can enter any combination of First Name, Last Name, Company, 
and Subject. The entries appear with the fax in the fax list.

4 Click Save.

View Fax Details

1 In the manager, select a fax in the fax list.

2 Choose Fax ➡ Show Details or right-click and choose Show Details.

3 Select the General tab to display Sender, Item, and Time and 
Size Information.

To display Transmission Information, select the Specific tab.

To display Least Cost Routing and Miscellaneous Information, select 
the Other tab.

Click View if you wish to view the current fax in the viewer.

Click Print Details to print the details.

4 Click Close.

Send Fax List Information to a File

The destination file can be a Microsoft® Excel comma separated file, 
(.csv) or a text file (.txt). Only the information pertaining to the 
columns displayed in the fax list is sent to the file.

1 In the manager, select one or more faxes in the fax list.

2 Choose Fax ➡ Send List to ➡ File or right-click and choose Send 
List to ➡ File.

3 Type a name, applying either the .csv or the .txt extension or use 
Browse to navigate to an existing file of either format to be 
overwritten.

Under Range, select All Items if the information for all faxes is to be 
sent to the file. Select Selected Items if only the faxes you selected in 
step 2 are to be considered.

Under Options, select Add Column title if you wish to include the fax 
list column headings.

To include each component fax of a broadcast fax, select Add 
Broadcast Items.

4 Click OK.
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Send Fax List Information to a Printer

Only the information pertaining to the columns displayed in the fax 
list is sent to the file.

1 In the manager, select one or more faxes in the fax list.

2 Choose Fax ➡ Send List to ➡ Printer or right-click and choose 
Send List to ➡ Printer.

3 Enter the printer information required.

4 Click OK.

Add a Column Heading

1 In the manager, position the cursor over a column heading. The new 
column heading will appear to the immediate right.

2 Right-click and choose Insert ... after the column.

3 Select the new column heading from the sub-menu. For example, 
choosing Item ➡ Status inserts the column heading in the fax list.

Replace a Column Heading

1 In the manager, position the cursor over the column heading you wish 
to replace

2 Right-click and choose Change the column for.

3 Select the new column heading from the sub-menu.

Delete a Column Heading

1 In the manager, position the cursor over the column heading you wish 
to delete

2 Right-click and choose Delete the Column.

Managing Faxes

Operations include viewing and printing faxes, transmitting faxes from 
the manager, deleting and —for administrators only— archiving faxes, 
and searching within the fax list.

View a Fax

1 In LightningFAX Manager, select the fax in the fax list.

2 Choose Fax ➡ View or right-click and choose View. LightningFAX 
Viewer is launched, displaying the first page of the fax.

Print a Fax

1 In LightningFAX Manager, select the fax in the fax list.

2 Choose Fax ➡ Print Faxes.

3 Select the printer options required.

4 Click OK.
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Transmitting from LightningFAX Manager

In addition to several means of sending a fax, you can pause or stop 
fax transmission.

Copy a Fax

1 In the manager, select the fax in the fax list.

2 Choose Fax ➡ Copy or right-click and choose Copy.

Use Group to select the group the recipient belongs to. Select All 
Groups to make all members of all groups available for selection. 
Select Ungrouped Users to make recipients who do not belong to any 
group available.

3 Under User List, select a recipient.

4 Click Add. Click Add All to copy to all recipients in User List.

To correct any errors, select a recipient under Recipient List and 
use Remove or Remove All.

5 Click Copy.

Pause a Fax

Pause can be applied only to faxes with a status of Ready to Send.

1 In the manager, select a fax with a status of Ready to Send.

2 Choose Fax ➡ Pause or right-click and choose Pause.

3 Click Yes.

Reroute a Fax

Reroute is only enabled for administrators. It takes a received fax and 
re-runs it automatically through the routing process.

1 In the manager, select a received fax in the fax list.

2 Choose Fax ➡ Reroute or right-click and choose Reroute.

3 Click Yes when prompted.

Route Faxes Manually

Routed faxes are removed from the fax list.

1 In the manager, select the fax in the fax list.

2 Choose Fax ➡ Route or right-click and choose Route.

Use Select a group to select the group the recipient resides in. Select 
All Groups to make all members of all groups available for selection. 
Select Ungrouped Users to make recipients who do not belong to any 
group available.

Use Select a user to select the recipient. Administrator is offered 
by default.

3 Click Route.
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Resubmit a Fax

Resubmit can be applied only to failed, paused, or successfully 
transmitted faxes. If you wish to resubmit a broadcast fax, you must 
select one of its component faxes.

1 In the manager, select a fax with a status of Failed, Paused, or Sent in 
the fax list.

2 Choose Fax ➡ Resubmit or right-click and choose Resubmit.

3 Click Now. 

You can change the prefix, the long distance code, the area code, the 
fax number, and the suffix if necessary.

4 Click Resubmit.

Resubmit a Fax at a Later Time

Resubmit can be applied only to failed, paused, or successfully 
transmitted faxes. If you wish to resubmit a broadcast fax, you must 
select one of its component faxes.

1 In the manager, select the fax with a status of Failed, Paused, or Sent 
in the fax list.

2 Choose Fax ➡ Resubmit or right-click and choose Resubmit.

3 Click Later.

Use Date to specify a date. Use Time to specify a time.

Click Phone if it is necessary to change the prefix, the long distance 
code, the area code, the fax number, or the suffix.

4 Click Resubmit.

Send a Fax as Email

1 In the manager, select one or more faxes in the fax list.

2 Choose Fax ➡ Send to ➡ Mail Recipient or right-click and choose 
Send To ➡ Mail Recipient.

Your default e-mail program is launched with the selected faxes 
included as attachments.

3 Address and send the e-mail.

Fax a Fax

1 In the manager, select one or more faxes in the fax list.

2 Choose Fax ➡ Send to ➡ SendFAX or right-click and choose Send To 
➡ SendFAX.

SendFAX is launched with the selected faxes inserted.

3 Address and send the fax.
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Stop Fax Transmission

Stop Transmission can be applied only to faxes with a status of 
Sending.

1 In the manager, select a fax with a status of Sending.

2 Choose Fax ➡ Stop Transmission or right-click and choose 
Stop Transmission.

3 Click Yes. The status is updated to Failed.

Delete a Fax

Faxes with a status of Ready to Send, Sending, LCR Ready, LCR 
Sending, and LCR Waiting for Retry cannot be deleted.

1 In the manager, select one or more faxes in the fax list.

2 Choose Fax ➡ Delete or right-click and choose Delete.

If archiving options and archiving notification are enabled, a message 
confirms that the deleted files will be archived.

If archiving options alone are enabled, a message confirms deletion.

If archiving options are not enabled, a message warns that the faxes 
will be deleted without being archived.

3 Confirm or cancel deletion.

Search the Fax List

You can specify a variety of means and search criteria.

Search Fax List by Text

Text searches are applied to the values displayed under the First 
Name, Last Name, Company, and Subject column headings.

1 In the manager, choose View ➡ Search. The fax list is modified to 
allow you to enter search criteria.

If necessary, use Filter to search current faxes, archived faxes or 
both.

If necessary, use Status to search only faxes of a particular status.

2 Type the search string in the Search Text field. The search string can 
include any values you expect to find in the First Name, Last Name, 
Company, and Subject columns.

3 Click Search.

The fax list will display all the faxes that met your search criteria.

4 Perform the operation you wish.

5 Click Close to restore the fax list view.
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Search Fax List by Fax Status

1 In the manager, choose View ➡ Search. The fax list is modified to 
allow you to enter search criteria.

If you wish, use Filter to search current faxes, archived faxes or both.

2 Use Status to select a particular fax status.

3 Click Search.

The fax list will display all the faxes that met your search criteria.

4 Perform the operation you wish.

5 Click Close to restore the fax list view.

Search Fax List by Date

1 In the manager, choose View ➡ Search. The fax list is modified to 
allow you to enter search criteria.

If you wish, use Filter to search current faxes, archived faxes or both.

If you wish, use Status to search only faxes of a particular status.

2 Use Date to select Today, From 1 week, or From 1 month.

3 Click Search.

The fax list will display all the faxes that met your search criteria.

4 Perform the operation you wish.

5 Click Close to restore the fax list view.

Search Fax List by Date - Advanced

1 In the manager, choose View ➡ Search. The fax list is modified to 
allow you to enter search criteria.

2 If you wish, use Filter to search current faxes, archived faxes or both.

Use Status to search only faxes of a particular status.

Use Date to select Custom.

Use Start Date to select the starting date of your search.

Use End Date to select the ending date of your search.

3 Click Search.

The fax list will display all the faxes that met your search criteria.

4 Perform the operation you wish.

5 Click Close to restore the fax list view.
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4 Fax Details Information

The Show Details menu selection of the manager displays detailed 
information about a fax selected from the fax list. This information can 
be viewed, but not modified.

Much of the information is common to all types of faxes, however, in a 
few cases, the fields displayed for outgoing, broadcast, and incoming 
faxes differ.

General Fax Details

Incoming Faxes

Sender Information

Field Description

Last Name The last name you specify through the Edit menu 
selection of the manager.

First Name The first name you specify through the Edit menu 
selection of the manager.

Company The company you specify through the Edit menu 
selection of the manager.

Subject The subject you specify through the Edit menu 
selection of the manager.
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Item Information

Time and Size Information

Field Description

Status The present status of the fax.

Error Code A failed transmission generates an error code. 
Click More for details. The value zero indicates 
that no error occurred.

Item Type indicates if the item is a broadcast head, archive 
or a single item.

Media Type indicates the media type, the value is Fax.

Resource indicates the resource used to transmit the fax.

Message ID A unique ID number assigned by LightningFAX 
for the selected fax. This ID number can be used 
to trace the fax at a later time.

Received Time The time and date a document was received by 
the Default Recipient before being routed to the 
final destination by an administrator or Super 
User.

In an environment where DID is implemented, 
the time and date indicate when a document was 
received by the DID number of the user.

Ack. Time Acknowledged Time indicates the time an item 
was viewed by the recipient.

Duration Time The actual transmission time indicated by the fax 
board.

Routed Time The time and date the fax was routed to the final 
destination is indicated as the routed time.

Number of Files If you receive a multi-page document, each page 
in your document is a file. A 10-page document 
will have 10 files. However, if you receive in 
multi-page TIFF format all the pages of your fax 
document are embedded in a single file.

Pages Received The number of pages received.
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Outgoing Faxes

Destination Information

Item Information

Time and Size Information

Field Description

Last Name The last name you specify through the Edit menu 
selection of the manager.

First Name The first name you specify through the Edit menu 
selection of the manager.

Company The company you specify through the Edit menu 
selection of the manager.

Subject The subject you specify through the Edit menu 
selection of the manager.

Application Name The name of the application used to send the fax.

Document Name The filename of the document sent.

Field Description

Status The present status of the fax.

Error Code A failed transmission generates an error code. 
Click More for details. The value zero indicates 
that no error occurred.

Item Type indicates if the item is a broadcast head, archive 
or a single item.

Media Type indicates the media type, the value is Fax.

Resource indicates the resource used to transmit the fax.

Message ID A unique ID number assigned by LightningFAX 
for the selected fax. This ID number can be used 
to trace the fax at a later time.

Has Cover Sheet The value Yes or No appears.

Field Description

Submitted Time The time and date a document was initially 
submitted for transmission.

Completed Time indicates the time when the LightningFAX driver 
actually completes the transmission.

Duration Time The actual transmission time indicated by the 
fax board.
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Specific Information

Transmission Information

Incoming and outgoing faxes display the following fields as 
Transmission Information.

Scheduled Time LightningFAX can be configured to send a fax 
within a specific period of time. For example, you 
may want to save on long distance charges by 
sending your faxes only during the discounted 
hours. LightningFAX indicates the beginning of 
that time period in this field.

Number of Files If you send a multi-page document, each page in 
your document is a file. A 10-page document will 
have 10 files. However, if you send in multi-page 
TIFF format all the pages of your fax document 
are embedded in a single file.

The number of files for Outgoing Head Broadcast 
faxes indicates the total number of fax recipients.

Page Submitted The number of pages submitted for transmission.

Pages Sent The number of pages transmitted.

Archived Time The time and date a document was stored in the 
archive database.

Field Description

Local CSID Your Call Station ID (outgoing only).

Callback Number Your callback number for outgoing faxes; the 
sender’s call back number for incoming faxes 
(outgoing only).

Remote CSID The sender’s CSID detected on an incoming fax.

Fax Number indicates the destination fax number (outgoing 
only).

Number of Retries 
Left

indicates the number or retries left before 
SendFAX stops attempting to transmit and sets 
the fax status to Failed (outgoing only).

Priority LightningFAX provides a 1-10 priority level to 
users. Level 1 is the highest priority level and can 
only be used by users granted this privilege by 
the administrator. The default priority level is 
three.

Speed indicates the speed of transmission in baud.

Channel Number indicates the channel of the fax board used to 
transmit the fax.
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Other Details

Other Details includes information on Least Cost Routing, which 
applies only to outgoing faxes, and miscellaneous information. The 
fields are identical for both incoming and outgoing faxes.�

Routing String indicates the user ID of the person who routed 
the fax to you or the routing information used for 
automatic routing using DID, DTMF, DNS, etc. 
(incoming only)

Routing Method indicates whether routing was automatic or 
manual (incoming only.)

Field Description

Field Description

Message ID This is a unique identifier assigned by 
LightningFAX for the selected fax item. This ID 
number can be used to trace the fax at a later 
time.

Resource indicates the resource used to transmit the fax.

Server Address indicates the IP Address of the Fax Server that 
transmits the selected fax item. In a network 
making use of least cost routing, this may not be 
the IP address of the fax server you logged in to.

Server Port indicates the port number of the server that 
transmits the selected fax item.

User ID indicates your user ID.

API Tag indicates the API tag number associated with the 
fax, which could be used by a system integrator 
for any purpose.

API Tag 2 offers an additional API field receiving a number 
as large as 10 digits.

Incoming or outgoing faxes display the following fields in two 
categories: Sender or Recipient.

Billing Code indicates the billing code assigned by the fax 
sender.

Sub Billing Code indicates the sub billing code assigned by the 
fax sender.
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5 Managing User Properties

This chapter describes how you can modify your user properties, 
whether to select a printer or to change transmission settings or to 
change your personal and company information.

Like your faxes, your user properties are managed through the 
manager.

Launching the Manager

Choose Start ➡ Programs ➡ LightningFAX ➡ LightningFAX 
Manager. 
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Access User Properties

❑ Select your user ID in the manager, right-click choose User 
Properties.

Information Routing User Settings Frequency

Personal Name

Company

Contact Numbers

Fax Forwarding

Printer ID

Archiving 
Options

Printing 
Options

Deleting 
Options

Notification 
Options

Refresh Rate

Manual Refresh

Notification 
Rate

Fax Settings Preference E-Mail

Number of 
Retries

CSID, Callback 
Number, Prefix, 
Suffix, and Fax 
Header

Default Tree 
View

Archive 
Confirmation

Notification

E-mail Address

LightningFAX 
Gateway
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User and Group Properties

Individual users and groups share many properties. When specified at 
the group level, a property’s value is applied to the same property at 
the user level if and only if no value is specified at the user level.

For example, if company information is specified at the group level and 
you belong to that group and have no company information specified 
in your user properties, your company information is the information 
specified for the group.

You can change that information by accessing your user properties and 
entering company information. In other words, user properties 
override group properties.

Administrators can prevent you from changing some properties by 
applying an Administrator Lock. When they do, you will not be able to 
make entries to the field in question.

Change your Password

1 In the manager, choose File ➡ Change Password.

2 Enter your current password.

3 Enter and confirm your new password.

4 Click OK.

Specify Personal Information

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Information tab.

3 Type a Salutation, First Name, Last Name and Job Title, 
if applicable.

First Name and Last Name should not be confused with the user 
ID. By default, users are identified in LightningFAX manager by user 
ID. First and Last names appear after the user ID only if they are 
added here.

4 Click OK.

Note: Personal information can also be specified in profile. If a profile 
is used, the personal information entered through user 
properties is overridden.

Specify Company Information

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Information tab.

3 Type the name and address information for the company in the 
appropriate fields.

4 Type your contact numbers and e-mail address.

5 Click OK.

Note: Company information can also be specified in profile. If a 
profile is used, the company information entered through user 
properties is overridden.
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Specify Fax Settings

Administrators can prevent you from changing these settings by 
applying an Administrator Lock.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Fax Settings tab.

3 Click Use these settings.

Type a Call Station ID (CSID), if desired.

Type a Callback Number, if desired.

Type a Prefix, if necessary. For example, some fax machines require 
that the number 9 be dialed to acquire an outgoing line. If that is the 
case, the entry 9, would be made here.

A comma can be used to specify a pause of one second. Whether such 
pauses are necessary is determined by the requirements of the 
telephone company or the PBX.

Type a Suffix, if necessary. For example, some telephone or PBX 
networks require the user to enter a code immediately after dialing a 
long distance number. If that is the case, the entry is made here.

If a fax header is to be included, click Edit Fax Header and define 
the header.

4 Click OK.

Note: If specified here, a CSID and a Callback Number override the 
CSID and callback Fax Number specified at the resource level.

Specify Number of Retries

1 In the manager, select your user ID, right-click and choose User 
Properties.

2 Select the Fax Settings tab.

3 Specify a Number of Retries. The default is three.

4 Click OK.

Specify Notification Options

Notification takes the form of the appropriate message displayed in a 
pop-up window. Notification messages are displayed when the 
manager is running and immediately upon launching the manager.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the User Settings tab.

3 Under Notifying Options, select Notify Success to notify after 
successful outgoing transmission.

To notify after outgoing transmission failure, select Notify Failed.

To notify after incoming fax receipt, select Notify New.

To notify after incoming fax failure, select Notify New Failed.

4 Click OK.
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Specify Email Notification Options

Email options are specified when an email gateway is installed. These 
options redirect incoming faxes from the Default Recipient in the 
manager to the user's email inbox and specify any desired notification 
options.

It should not be necessary to underline that e-mail options are 
meaningless if no gateway is installed and, of course, you must know 
which email gateway is being used.

1 In the manager, select your user ID, right-click and choose User 
Properties.

2 Select the E-mail tab.

3 Select Notify Success to notify the user after successful 
outgoing transmission.

To notify after failed outgoing transmission, select Notify Fail.

To notify after new incoming transmission, select Notify New.

4 Type the E-mail Address.

Note: If the gateway for R/3 is installed, the entry to E-Mail Address 
is your R/3 user's personal fax number.

5 Select the gateway.

6 Click OK.

Change Notification Rate

Notification rate represents the interval LightningFAX waits before 
polling for new notification messages. Notification rate cannot be 
changed from the default if Notifying Options have not been specified.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Frequency tab.

3 Under Notification Rate, position the slider nearer to High or to 
Low.

4 Click OK.

Specify Archiving Options

Administrators can prevent you from changing archiving options by 
applying an Administrator Lock.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the User Settings tab.

3 Under Archiving Options, select Archive Details to archive fax 
details only.

To archive both messages and details, select Archive Messages 
and Details.

4 Click OK.
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Specify Deleting Options

If archiving is enabled, deletion removes faxes from only the manager; 
the faxes remain in the archive. If archiving is not enabled, deletion 
permanently removes the fax message. An administrator must 
authorize the deletion of archived items.

An administrator can prevent you from changing deleting options by 
applying an Administrator Lock.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the User Settings tab.

3 Under Deleting Options, select Delete after Success to 
automatically delete fax messages after successful outgoing 
transmission.

To automatically delete fax messages after outgoing transmission 
failure, select Delete after Fail.

To automatically delete incoming fax messages after printing, select 
Delete after Printing New.

To automatically delete incoming fax messages after failure, select 
Delete New Failed.

4 Click OK.

Archiving Confirmation on Deletion

If archiving options are selected and an administrator has instructed 
LightningFAX to confirm archiving on deletion, LightningFAX informs 
you that the fax you are deleting will be archived.

If archiving options are not selected and confirmation is set, 
LightningFAX informs you that the fax you are deleting will not be 
archived. You can cancel deletion.

If archiving options are selected and confirmation is not set, 
LightningFAX asks you to confirm deletion.

To change whether confirmation messages are displayed or not 
displayed:

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Preference tab.

3 Select or deselect Confirm whether items will be archived 
when deleted.

4 Click OK.
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Select a Printer

An administrator must first configure a printer and tell you the 
printer’s ID number before you can select it. Administrators 
can prevent you from changing this setting by applying an 
Administrator Lock.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Routing tab.

3 Under Printer ID, type the Printer ID.

4 Click OK.

Specify Printing Options

An administrator can prevent you from changing this setting by 
applying an Administrator Lock.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the User Settings tab.

3 Under Printing Options, select Print Details on Success to 
automatically print fax details after successful outgoing transmission.

To automatically print fax details after outgoing transmission failure, 
select Print Details on Failed.

To automatically print fax details on incoming fax receipt, select 
Print Details on New.

To automatically print fax details when an incoming fax fails, select 
Print Details on New Failed.

To automatically print the fax after successful outgoing transmission, 
select Print Message on Success.

To automatically print the fax after outgoing transmission failure, 
select Print Message on Failed.

To automatically print the fax on incoming fax receipt, select Print 
Message on New.

To automatically print the fax when an incoming fax fails, select Print 
Message on New failed.

4 Click OK.

Specify Fax Forwarding

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Routing tab.

3 Under Forwarding Faxes, select Forward to.

4 Use the Group list to display only members of a given group or to 
display all ungrouped users.
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5 Select a LightningFAX user as the recipient.

6 Click Transfer if faxes are to be transferred. Click Duplicate if faxes 
are to be copied.

7 Click OK.

Change the Refresh Rate

Refresh rate is the frequency at which the manager updates the display 
of fax messages.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Frequency tab.

3 Position the slider under Refresh Rate nearer to High or to Low.

4 Click OK.

Select Manual Refresh

The refresh rate slider is not available when manual refresh is selected.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Click the Frequency tab.

3 Under Refresh Rate, select Manual Refresh.

4 Click OK.

Specify Default Resource for Outgoing Faxes

An administrator can prevent you from selecting a default resource.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Fax Settings tab.

3 Under Default Resource, select a resource. Only the resources you 
can access are available.

4 Click OK.

Specify Least Cost Routing (LCR) for Outgoing Faxes

Least cost routing (LCR) and load balancing must first be configured 
by an administrator. An administrator can prevent you from selecting 
LCR.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Fax Settings tab.

3 Under Default Resource, select Use LCR. Default Resource is 
dimmed. Your outgoing faxes will be sent by the resource configured 
for LCR.

4 Click OK.
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Advanced User Properties

Advanced properties govern the tree view and you can modify these 
properties only if an administrator has given you the right to. If you 
can see only your user ID and your fax folders in the tree view in 
LightningFAX Manager, you have a restricted view.

Change the Tree View

Administrators and Super Users can toggle between a restricted and an 
unrestricted tree view. However, an administrator can prevent other 
users from changing this setting.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Preference tab.

3 Deselect Show me a Restricted View.

4 Click OK.

Hide Other Users

An administrator can prevent you from changing this setting.

1 In the manager, select your user ID, right-click and choose 
User Properties.

2 Select the Preference tab.

3 Select I do not want to see other users.

4 Click OK.

Show User ID and Full Name

An administrator can prevent you from changing this setting.

1 In the manager, select your user ID, right-click and choose User 
Properties.

2 Select the Preference tab.

3 Select Show me the full name and User ID to display those items.

Select Show me only the User ID to display only that.

4 Click OK.
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6 Introducing SendFAX

This chapter details SendFAX, the principal faxing interface. 
Operations described include:

Launching SendFAX

❑ Choose Start ➡ Programs ➡ LightningFAX ➡ SendFAX.

❑ In the manager, choose Tools ➡ SendFAX.

Usually, To receives the name. Destination, which is the only 
mandatory field of the four, receives either the fax number or the 
email address.

❑ addressing a transmission ❑ inserting, modifying, and 
annotating a document

❑ adding a cover sheet ❑ selecting or generating a profile

❑ changing transmission settings ❑ selecting a phone book

❑ altering sender and recipient 
information

❑ modifying the interface

 

The Default SendFAX Interface

Menus and toolbars 
aside, the default 
interface after initial 
installation is divided 
into four main areas or 
panes. 

The Manual Addressing 
Fields — To, Company, 
Destination, and 
Subject — allow you to 
type recipient 
information directly.

Manual
Addressing

Fields
Fax Recipient List

Thumb-
nail
View

Fax Preview
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The Fax Recipient List displays the individuals and groups who are 
to receive the transmission, either selected from a phone book or typed 
directly into the manual addressing fields.

The Thumbnail View displays successively a reduced image of each 
page of the fax. The default reduction is 13 per cent of the original. A 
scrollbar enables you to view any page. You can also widen the 
Thumbnail View itself. Selecting a page in the Thumbnail View 
displays that page in the Fax Preview. The Thumbnail View also makes 
it possible to reorder and delete pages from the fax you are composing.

The Fax Preview displays a single page of the fax at a time. The default 
size is 100 per cent of the original. It is here that you add annotations 
to a fax before transmission. Annotations can include text; highlight; 
bitmap images; lines and rectangles.

SendFAX also provides the means to select a profile, a cover sheet, to 
display a contact list of potential fax recipients from one of several 
phone available to you. You can alter transmissions settings, modify 
your sender and recipient information, and change the interface to suit 
your requirements.

The File Menu

New cancels the current fax, clearing the fax recipient list and begins a 
new one.

Insert lets you insert a file into your fax.

Save As lets you save your fax in a local or network directory.

Save Profile creates a profile based on the current fax, user, cover 
sheet, and fax header settings. See Chapter 11 Introducing Profiles for 
the information about creating and using profiles.

Print lets you send the fax message to a physical printer or an 
LightningFAX printer driver.

Send sends the fax and closes the SendFAX interface.

Send Without Closing sends the fax but keeps the SendFAX interface 
open, for example, to allow you to send the same fax to other 
recipients.

Logon opens the logon dialog box, allowing you to change the fax 
server or account you are logged on to.

Exit closes SendFAX.
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The Edit Menu

Sender opens the Sender Information dialog box, allowing you to 
modify the information about you sent with the fax.

Transmission Settings opens the Transmission Settings dialog box. 
You can set the fax header, dialing options, calling options, and timer 
settings for the fax.

Fax Recipient opens the Edit Contact window, allowing you to modify 
the information about a selected fax recipient in the fax recipient list.

Cover Sheet Comments lets you enter a comment in your cover sheet in 
the preview window.

The View Menu

Toolbar allows you to display the different SendFAX toolbars. When a 
toolbar is visible, a check mark appears beside its name. There are four 
different Toolbars to choose from: Main, Preview, Thumbnail, and 
Annotation.

Status Bar displays or hides the Status Bar. A checkmark appears 
beside it when it is visible.

Phone Book displays a submenu whose selections switch the display of 
(a) the manual addressing fields and the fax recipients with (b) the 
contact selection pull-down list and the contact list. 

Full Preview, if selected, displays only the thumbnails and fax 
preview. The display of the manual addressing fields, the fax recipient 
list, and the contact information is suspended. Deselecting Full 
Preview redisplays that information in the SendFAX window.

Options can display three tabs:

General offers toggles for the display of names from the available 
phone books, such as the public phone book, the LightningFAX 
network user IDs, the phone book service, and the MAPI and Lotus 
Notes address books, if these are installed. It also offers toggles for the 
display of cover sheets available, both on the server and on the local 
computer.

MAPI and Lotus (if installed) display settings for billing and 
sub-billing code mapping.

The Thumbnail Menu

Delete removes pages selected in the thumbnail view from your fax.

Move offers menu selections that move the selected page up one page, 
down one page, to the first page after a cover sheet, or the last page of 
the fax. Page numbering is automatically adjusted.

Mark As ➡ Do Not Send instructs SendFAX to exclude the page selected 
in the thumbnail view when you transmit the fax. Mark As � Send 
restores an excluded page to Send.

Zoom increases or decreases the magnification of pages in the 
thumbnail view.
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The Preview Menu

First Page lets you view the first page of your fax.

Previous Page lets you view the previous page of your fax.

Next Page lets you view the next page of your fax.

Last Page lets you view the last page of your fax.

Best Fit displays the page at the magnification that best fits the 
preview window.

Fit to Width displays the page at the maximum width that fits in the 
preview window.

Fit to Height displays the page at the maximum height that fits in the 
preview window.

Zoom lets you choose one of the preset magnification values. 

The Annotations Menu

Annotations are objects that a user may add to draw attention to 
certain parts of a fax.

Add displays a submenu that lets you add an annotation to your fax. 
Annotation types include: Text, Line, Rectangle, Stamp, and 
Highlight.

Delete lets you remove an annotation. Select the annotation and click 
Delete.

Show Annotation toggles the display of the annotations on a fax page 
and the availability of the Annotation toolbar. If annotations are not 
displayed, the toolbar is not available. A check mark appears beside 
this menu selection when annotations are displayed.

Select All selects all the fax annotations on the current page.

Unselect All deselects all selected fax annotations.

Properties changes the properties of line, rectangle, and text 
annotations. Properties include color and line thickness, as well as font 
and type size for text annotations.

See Chapter 12 About Annotations for full information.

The Tools Menu

LightningFAX Phone Book launches the phone book window through 
which you can create a new phone book, update contacts in an existing 
one, and select a phone book and contact list for sending faxes. See 
Chapter 8 Introducing Phone Books, for detailed information.

MAPI Address Book launches your MAPI Address Book in which you 
can enter contact information.

Profile Management launches the Profile Management window. See 
Chapter 11 Introducing Profiles, for further information.
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Managing Phone Books

The default interface can be customized in a variety of ways. The most 
frequent change is to display a contact list from a phone book. Phone 
book information can be displayed on the left or right of the interface.

Note: This documentation assumes that phone book information is 
displayed on the right side of the SendFAX interface.

Display Phone Books and Address Books

1 In SendFAX, choose View ➡ Options.

2 Select LightningFAX Phone Book, LightningFAX Users, Phone 
Book Service, MAPI Address Book or Lotus Notes Address Book.

3 Click OK.

Public Phone Books

The Phone Book service is a public phone book assigned to a group by 
an administrator. The primary members of the group are automatically 
granted access to the phone book. The same menus and operations 
used to manage private phone books are used to manage public phone 
books. However, the contents are read-only for all users except 
administrators.

Administrators can create a public phone book only if the Phone Book 
service has been installed.

All other phone books are private to you.

Note: Only administrators can create and manage a public phone book.

  

SendFAX Interface with Phone Book
(Show Right)

SendFAX Interface with Phone Book
(Show Left)

Manual Addressing 

Fax Recipient List

Fax PreviewThumb-
nail

View

Phone Book
and Contact List

Phone Book
and Contact List

Fax Recipient List

Fax PreviewThumb-
nail
View

Manual Addressing Fields
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Move Phone Book Display

1 In SendFAX, choose View ➡ Phone Book.

2 Choose Show Right to display the phone book on the right side of the 
SendFAX interface.

Choose Show Left to display the phone book on the left side of 
the interface.

Cancel Phone Book Display

1 In SendFAX, choose View ➡ Phone Book.

2 Deselect Show Right or Show Left, whichever is selected. The phone 
book is removed from the SendFAX interface.

Select a Contact List

1 In SendFAX, choose View ➡ Phone Book ➡ Show Right or Show Left, 
if the phone book is not displayed,

2 Use Show names from the to display phone books, the MAPI address 
book, or any other address book available to you.

3 Select the contact list displayed under the title of the address or phone 
book.

Toggle Phone Book Availability

1 In SendFAX, choose View ➡ Options.

2 Select the General tab.

3 Select or deselect LightningFAX Phone Book, LightningFAX Users, 
Phone Book Service, MAPI Address Book, or Lotus Notes 
Address Book.

4 Click OK.

Addressing Transmissions

You can address a transmission manually or by selecting a recipient 
from one of your phone books.

Manually Address a Transmission

1 In SendFAX, type an entry in the To field.

If desired, type an entry in the Company field.

2 Type a fax number or email address in the Destination field. Only 
this entry is mandatory.

If desired, type an entry in the Subject field.

Note: If the phone book is not displayed on the right of the SendFAX 
interface, choose View ➡ Phone Book ➡ Show Right.

3 Click .

The recipient is copied to the list under Fax Recipients.
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Select a Recipient from a Phone Book

1 In SendFAX, choose View ➡ Phone Book ➡ Show Right if the phone 
book is not displayed on the right of the SendFAX interface, 

If necessary, use Show names from the to select the contact list.

2 Type a recipient’s name or select a group or individual recipient from 
the contact list.

3 Click .

The recipient is copied to the list under Fax Recipients.

Select a Recipient from a Phone Book (not displayed)

Note: The following operation describes how to select a recipient from a 
phone book when the phone book is not displayed in the SendFAX 
interface.

1 In SendFAX, click . SendFAX displays the phone book in a separate 
window.

If necessary, use Show names from the to select the correct phone 
book and contact list.

2 Type the name or select the recipient from the phone book.

3 Click .

Repeat steps 2 and 3 for each recipient desired.

4 Click OK.

Edit Recipient Information

1 Under Fax Recipients, select the fax recipient.

2 Choose Edit ➡ Fax Recipient or click .

3 Make your modifications or additions.

4 Click OK.

Quickly Change Recipient Destination

This procedure lets you change the destination of a recipient, by 
selecting it from a list of available destinations.

1 In SendFAX, address the fax manually or select a recipient from the 
contact list.

2 Under Fax Recipient, right-click on the recipient and select 
Destinations.

3 Select the preferred destination from the list.



Chapter 6 Introducing SendFAX

62 LightningFAX User Guide

Cancel Transmission to a Recipient

Canceling transmission to a recipient instructs SendFAX not to 
transmit to that recipient but leaves the recipient listed under Fax 
Recipients. You cancel transmission when you wish to recompose 
messages to be sent to different groups of recipients. For example, 
some recipients are to receive one document; others are to receive that 
and a second document. You can insert the first document and add all 
recipients, canceling those who are to receive two documents. You 
transmit the fax, then add the second document.

❑ Deselect  to the left of the recipient’s name under Fax Recipients.

Delete a Recipient from the Fax Recipient List

1 Select the recipient in the list under Fax Recipients.

2 To the right of Fax Recipients, click .

Managing Fax Documents

This section describes how documents can be placed within SendFAX 
for transmission.

Insert a Document

1 In SendFAX, choose File ➡ Insert or click .

2 Navigate to the document you wish to transmit and select it.

3 Click Open.

Repeat steps 2 to 3 as often as required.

Note: If the correct folder is open on your desktop, you can drag and 
drop documents directly to SendFAX.

Reorder Fax Pages

1 With a fax of two or more pages open in SendFAX, select a page in the 
Thumbnail View.

2 Choose Thumbnail ➡ Move then choose First, Up, Down, or Last, 
as required.

Alternatively, click  or  above the Thumbnail View to move the 
page as desired.

Cancel Transmission of a Page

Note: A canceled page is not transmitted with the rest of the fax.

1 Open a fax in SendFAX, and select the page in the Thumbnail View.

2 Choose Thumbnail ➡ Mark As ➡ Do Not Send.

Alternatively, click  above the Thumbnail View.
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Restore a Canceled Page

1 Select the canceled page in the Thumbnail View.

2 Choose Thumbnail ➡ Mark As ➡ Send to restore a canceled page.

Delete a Page from a Fax

1 Open a fax in SendFAX and select the page in the Thumbnail View.

2 Choose Thumbnail ➡ Delete.

Alternatively, click  above the Thumbnail View.

3 Confirm deletion.

Managing Cover Sheets

LightningFAX makes several default cover sheets available for 
selection. In addition, the Cover Sheet Editor allows you to compose 
and save your own cover sheets. See Chapter 10 Introducing the Cover 
Sheet Editor for full information on generating cover sheets for use 
with SendFAX.

Select a Cover Sheet

1 In SendFAX, use  to select More Cover Sheets.

By default, cover sheets are stored in the 
profile\username\Application Data\Interstar 
Technologies\LFClient\Cover folder. However, cover sheets can 
be stored in any folder. If necessary, navigate to another folder.

2 Select the cover sheet you want.

3 Click Open.

The cover sheet remains selected the next time you launch SendFAX.

Cancel a Selected Cover Sheet

❑ In SendFAX, use  at the right of the current cover sheet name to 
select No Cover Sheet.

Add a Comment to a Cover Sheet

1 In SendFAX, select a cover sheet, if one is not selected.

2 Choose Edit ➡ Cover Sheet Comments.

3 Type the comment.

Toggle Cover Sheet Availability

1 In SendFAX, select View ➡ Options.

2 Select the General tab.
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3 Under Show Cover Sheets From, select or deselect LightningFAX 
Server or Local Machine.

LightningFAX Server governs cover sheets stored on the server. 
Local Machine governs cover sheets stored on your computer in the 
profiles\username\Application Data\Interstar 
Technologies\LFclient\Cover folder.

4 Click OK.

Managing Profiles

Profiles serve a variety of purposes. Sender information, your name 
and contact numbers, as well as company information, can be stored in 
a profile. Profiles can specify a cover sheet which is used whenever you 
transmit through SendFAX with that profile. Profile can store sender 
billing information. A profile can also include a fax header.

Although administrators often compose profiles and make them 
available to users, users can compose profiles of their own whenever 
necessary.

See Chapter 11 Introducing Profiles for more information.

Select a Profile

Note: This operation requires at least one already-defined profile.

1 In SendFAX, use the first selection box to select the profile.

The selected profile remains selected the next time you launch 
SendFAX.

Cancel a Selected Profile

1 In SendFAX, use  at the right of the current profile name to select 
No Profile.

Generate a Profile in SendFAX

1 In SendFAX, use  to select the profile you wish to copy if the new 
profile is be based on an existing one, 

Alternatively, to generate an entirely new profile, use  to select 
No Profile.

2 Choose File ➡ Save Profile.

3 Type a new name in the Profile Name field.

4 Type your modifications or additions.

5 Click OK.
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Fax from SendFAX

1 Launch SendFAX.

If desired, select a profile.

If desired, select a cover sheet.

2 Insert one or more documents.

If desired, reorder, cancel, or delete fax pages.

If desired, add annotations in Fax Preview.

3 Manually address the transmission or select one or more recipients 
from the contact list.

You can select a different contact list to select other recipients.

Make whatever modifications or additions you require to the 
sender information.

Make whatever modifications or additions you require to the fax 
recipient information.

If required, change the transmission settings.

4 Choose File ➡ Send or click Send to transmit immediately and 
close SendFAX. You can also use either of the following hotkey 
combinations: Ctrl + Enter or Alt + s.

Choose File ➡ Send without Closing if you wish to compose 
another transmission.

Advanced Transmission Settings

Advanced transmission settings include:

Edit Sender Information

Changes to sender information in SendFAX are applied to a single 
transmission. For example, you might send a fax on behalf of another 
user and change the Name information to reflect that operation.

Sender information includes your name and title; company name and 
address; your telephone, cellular, and fax numbers, and email address; 
and sender billing information.

❑ Changing Sender 
Information

❑ Specifying a Call 
Station ID

❑ Specifying a 
Callback Number

❑ Changing Dialing 
Options

❑ Changing Calling 
Options

❑ Scheduling 
Transmission

❑ Selecting an 
Outgoing Resource

❑ Using Least Cost 
Routing

❑ Saving a 
Transmission

❑ Adding a Fax 
Header
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1 In SendFAX, choose Edit ➡ Sender or click .

If sender information has already be specified, those entries appear.

2 Type your modifications or additions.

3 Click OK to apply the sender information to the current transmission 
alone.

4 Click Save, OK, and then OK to apply the information and update your 
user properties.

Add or Change a Call Station ID (CSID)

A Call Station ID (CSID) can be specified at several levels, on a 
resource, in a profile, in user or group properties. The operation 
described here overrides any CSID specified at any location.

Note: Administrators can deny users the right to change a CSID.

1 In SendFAX, choose Edit ➡ Transmission Settings or click .

2 Type the Call Station ID in the CSID field. If a CSID was already 
assigned, it will appear in that field. If you do not have the right to 
change a CSID, the field is dimmed.

Click Restore to correct any errors.

3 Click OK to apply the CSID to the current transmission alone.

Click Save then OK to apply the CSID and save it to your user 
properties.

Add or Change a Callback Number

A callback number can be specified at several levels, on a resource, in a 
profile, in user or group properties. The operation described here 
overrides any callback number specified at any location.

Note: Administrators can deny users the right to change a callback 
number.

1 In SendFAX, choose Edit ➡ Transmission Settings or click .

2 Type the callback in the Callback Number field. If a callback was 
already assigned, it will appear in that field. If you do not have the 
right to change a callback number, the field is dimmed.

Click Restore to correct any errors.

3 Click OK to apply the callback number to the current transmission 
alone.

Click Save then OK to apply the callback number and save it to your 
user properties.
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Add or Change Dialing Options

Dialing options can include a prefix, a number to be dialed before the 
actual fax number, or a suffix, a number to be dialed after the fax 
number. The first might be the code used to access an outgoing 
telephone line, the second might be a code that permits you to make a 
long distance call.

Note: Administrators can deny users the right to change dialing options.

1 In SendFAX, choose Edit ➡ Transmission Settings or click .

2 Type a Prefix or a Suffix or both.

Click Restore to correct any errors.

3 Click OK to apply the dialing options to the current transmission alone.

Click Save then OK to apply the dialing options and save them to your 
user properties.

Add or Change Calling Options

Calling options include the number of retries and the priority. These 
can be set in other locations. Changes made here override those 
settings.

Note: Administrators can deny users the right to change calling options.

1 In SendFAX, choose Edit ➡ Transmission Settings or click .

2 Type a Priority. The default is three; the range extends from one, the 
highest, to 10 the lowest.

Type a Number of Retries. The default is three; 99 is the highest 
available number.

Click Restore to correct any errors.

3 Click OK to apply the calling options to the current transmission alone.

Click Save then OK to apply the calling options and save them to your 
user properties.

Schedule Transmission

Note: Only messages destined for fax recipients (not email or 
LightningFAX recipients) can be scheduled for later transmission.

1 In SendFAX, choose Edit ➡ Transmission Settings or click .

2 Under Timer Settings, select From.

3 Use  to display a calendar and select a date.

Select a specific hour and minute. Date and hour can be combined.

Timer settings, if specified, become the default. Select As soon as 
possible when it becomes necessary to cancel them.

Click Restore to correct any errors.
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4 Click OK to apply the timer settings to the current transmission alone.

Click Save then OK to apply the timer settings and save them to your 
user properties.

5 Choose File ➡ Send or click Send.

If an administrator has configured it, a prompt will ask you to enter a 
billing code or a billing and sub-billing code. Enter one or both values 
in Billing Code and Sub Billing Code.

You can eliminate this prompt by entering the billing code information 
in your sender information before transmitting the fax.

Select an Outgoing LightningFAX Resource

An administrator can prevent you from selecting an outgoing resource.

1 In SendFAX, choose Edit ➡ Transmission Settings or click .

2 Under Resource, use  to select a resource. The transmission will be 
sent through this resource.

Click Restore to correct any errors.

3 Click OK to send only the current transmission by the resource.

Click Save then OK to apply the resource selection and save it to your 
user properties.

Transmit using Least Cost Routing and Load Balancing

To be successfully used, a least cost routing table must be already 
established. An administrator can prevent you from selecting LCR.

1 In SendFAX, choose Edit ➡ Transmission Settings or click .

2 Under Resource, select Use LCR. The Resource selection is dimmed.

3 Click OK to apply least cost routing and load balancing to the current 
transmission only.

Click Save then OK to apply least cost routing and load balancing and 
save that selection to your user properties.

Save a Fax Transmission

1 In SendFAX, compose the transmission, inserting one or several 
documents.

2 Choose File ➡ Save As.

If necessary, navigate to the preferred directory.

3 Type a File name. The .tif format is applied automatically.

4 Click Save.
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Add or Edit a Fax Header

A fax header can be specified at several levels, on resource, in a profile, 
in user or group properties. The operation described here overrides 
any fax header specified at any location.

If a fax header is already selected, through a profile or resource, these 
operations allow you to edit it.

Note: Administrators can deny users the right to change a fax header.

1 In SendFAX, choose Edit ➡ Transmission Settings or click .

2 Click Edit Fax Header.

3 Compose or edit the fax header.

Click Restore to correct any errors.

4 Click OK to apply the fax header to the current transmission alone.

Click Save then OK to apply the fax header and save it to your 
user properties.

MAPI Address Books and Billing Information

MAPI address books can be made available in SendFAX. Most MAPI 
fields are automatically mapped to corresponding LightningFAX phone 
book fields, with two exceptions: Billing Code and Sub Billing 
Code.

A MAPI address book user can however enter billing information in a 
field in a MAPI address book and then instruct SendFAX to map those 
fields to Billing Code and Sub Billing Code.

1 In SendFAX, choose View ➡ Options.

2 Select the MAPI tab.

3 Use LightningFAX Field to select Billing Code or Sub 
Billing Code.

4 Use MAPI Property to select the MAPI field that contains the 
billing information.

MAPI Property Value displays the value of the MAPI Property for 
the selected contact.

Note: This MAPI Property can be selected, even if the warning 
There is no value defined for this property is displayed.
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Advanced Display Management

The following operations change the display, either of the document 
being transmitted or of the SendFAX interface itself.

Preview Fax Pages

With a fax of two or more pages open in SendFAX:

❑ Choose Preview ➡First Page or click  to preview the first page.

❑ Choose Preview ➡ Previous Page or click  to preview the 
previous page.

❑ Choose Preview ➡ Next Page or click  to preview the next page.

❑ Choose Preview ➡ Last Page or click  to preview the last page.

These menu selections and buttons are available only when the page is 
available for selection.

Zoom the Thumbnail View

With a cover sheet or a fax open in SendFAX:

❑ Choose Thumbnail ➡ Zoom or use  above the Thumbnail View to 
select a zoom percentage.

Values available are 13, 14, 15, 20, 25, 30, 35, 40, 45, 50, 75, and 100 
per cent of the original.

Zoom the Fax Preview

With a cover sheet or a fax open in SendFAX:

❑ Choose Preview ➡ Zoom or use  above Fax Preview to select a 
zoom percentage.

Values available are 25, 50, 75, 100, 150, and 200 per cent of the 
original.

Alternatively, choose Preview ➡ Best Fit or click  to select the 
best fit in the Fax Preview pane.

Choose Preview ➡ Fit to Width or click  to select Fit to Width, 
width being the width of the Fax Preview page.

Choose Preview ➡ Fit to Height or click  to select Fit to Height, 
height being the height of the Fax Preview page.

Display Full Preview

Full Preview cancels the display of the manual addressing fields, the 
phone book, and the fax recipient list. Only Thumbnail View and Fax 
Preview remain.

❑ In SendFAX, choose View ➡ Full Preview or click .

The same steps restore the default interface, canceling Full Preview.
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Cancel Addressing Fields Display

❑ In SendFAX, click  above the fax recipients list. The display of the 
manual addressing fields is canceled and the fax recipient list is 
expanded.

Click  to restore the manual addressing fields.
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7 Fax Utilities in LightningFAX

LightningFAX makes available several utilities that allow you to send 
transmissions without using SendFAX, the email gateways, or forms 
for Microsoft Outlook. This chapter details those functions and 
utilities.

Faxing from Windows Applications

If SendFAX is installed on your computer, you can fax from any 
Windows application that is also installed on your system.

Note: Microsoft Word is the program used to describe faxing from 
Windows applications. However, you can perform the same faxing 
operations from any Windows application with print capabilities.

To send a fax from Word:

1 Create or open the document you want to fax.

2 Choose File ➡ Print.

3 Use Name to choose LightningFAX.

4 You can specify any page range available to you through the 
application’s print options.

Most of the print options offered by the application are available. For 
example, in Microsoft Word, you can choose Options and instruct 
Word to print in reverse order.

5 Click OK.

SendFAX is launched and you are prompted to log on.

6 Address the fax.

You can add a profile or a cover sheet or make an entry to the Subject 
field, 

7 Click Send.
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Send a fax with a specific resolution

To send a fax from an external application, with a specific resolution:

1 In the application, create or open the document you want to fax.

2 Access the printing properties dialog, usually from the File menu.

3 In the Select Printer section of the dialog, select the printer as 
LightningFax.

4 Click the Paper/Quality tab (if available).

5 Click on the Advanced button.

6 Set the printer driver's resolution in the Graphic-Print Quality 
field. Choices are Low(200x100) and High(200x200).

Note: This changes the printer resolution for the whole system, and 
remains so until it is changed again, using the above procedure.

The Fine(300x300) and Ultra Fine(400x400) 
resolutions (when supported) can only be enabled by creating 
and modifying a registry key. Call your Interstar technical 
support representative, for more details.

7 Depending on the application you are using, click the Print button, or 
exit the printer properties dialog and select File ➡Print.

8 If the printer properties dialog appears again, click OK to close it, as 
the properties are already set.

SendFAX is launched and you are prompted to log on.

9 Address the fax.

You can add a profile or a cover sheet or make an entry to the Subject 
field, 

10 Click Send.

Mail Merge for Word

Mail Merge for Microsoft® Word enables you to merge a Main 
Document and a Data Source written in Word and to fax the Main 
Document to all recipients recorded in the Data Source.

Note: You should speak to your system administrator if Mail Merge for 
Microsoft® Word is not installed on your computer.

The first step is create a Main Document, which is the actual fax 
message, entering Word merge fields which receive the information 
entered in the Data Source. Although any of the Word merge fields can 
be selected, FirstName, LastName, Company, and WorkPhone are 
recommended. A Data Source is then created. The entries made to the 
Data Source are the information to appear in the Word merge fields. 
Both Main Document and Data Source can then be saved.
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The second step is to open the Main Document, map the LightningFAX 
merge fields to the Word merge fields and fax the document.

Mail Merge for Word offers four merge fields: First Name, Last Name, 
Company, and Fax Number. These are mapped to the Word merge 
fields you select.

The fax operation itself is accomplished through SendFAX. A fax is 
sent to each entry in the Data Source.

Note: Because of a limitation in the printer driver, the contents of the 
LightningFAX merge fields in the Data Source must not exceed, 
in the number of pages (i.e. the number of page breaks), the 
size of the Word merge fields in the Main Document, otherwise 
the SendFAX transmission will fail.

Mail Merge for Word must first be installed.

Create a Main Document and a Data Source in Word

1 Launch Word.

2 Choose Tools ➡ Mail Merge from the Word menu.

3 Click Create and choose Form Letters.

4 Click Get Data and choose Create Data Source.

Although any of the Word fields can be selected, FirstName, 
LastName, Company, and WorkPhone correspond most closely the 
LightningFAX merge fields.

5 Click Edit Data Source.

6 Enter the FirstName, LastName, Company, and WorkPhone 
information for as many fax recipients as required.

Note: Omitting a fax number in the WorkPhone field produces an 
error message when you attempt to fax with SendFAX.

7 Click OK.

8 Write the fax message as the Main Document. Use Insert Merge 
Field to insert the FirstName, LastName, Company, and WorkPhone 
merge fields wherever they are needed.

Note: Do NOT use Word’s Merge the data with the 
document command.

9 Save both documents.

Note: Although the above example assumes that the data source is itself 
a Word document, Word’s mail merge operation accepts data 
sources from other programs, Excel, for example. For the best 
performance when faxing, however, Interstar recommends that 
you always use a data source created in Word.
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Fax using Mail Merge for Word

1 Exit SendFAX if it is running.

2 Open a Main Document written in Word.

3 Click .

4 Use First Name to map to the Word's FirstName merge field.

Use Last Name to map to the Word's LastName merge field.

Use Company to map to the Word's Company merge field.

Use Fax Number to map to Word's WorkPhone merge field.

Note: Mapping is not saved. The next time you fax a Main Document, 
you must again map the LightningFAX fields to the Word merge 
fields.

5 Click OK. Word generates a Main Document for each fax recipient 
recorded in the data source.

The Print window is displayed with LightningFAX selected as the 
printer.

6 Click OK. SendFAX is launched and you are prompted to log on.

The fax is displayed in SendFAX with the first record in the Data 
Source as its recipient. All fax recipients from your Data Source appear 
in the list of Fax Recipients.

You can add a profile or a cover sheet, make an entry to the Subject 
field, and choose not to send a fax to a given recipient.

Note: You cannot add other fax recipients or documents to the fax.

7 Click Send.

Fax from Microsoft Word

If you are using Microsoft Word, and Mail Merge for Word is installed, 
you can fax any Word document using the following procedures.

1 Launch Word.

2 Compose your fax message.

3 Click .

SendFAX is launched and you are prompted to log on.

4 Address the fax.

You can add a profile or a cover sheet or make an entry to the Subject 
field, 

5 Click Send.
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Send a fax with a specific resolution

To send a fax from Microsoft Word, with Mail Merge and a specific 
resolution:

1 In Word, select File ➡ Print.

2 In the Printer section of the dialog that appears, select the printer 
Name as LightningFax or Print to mail.

3 Click Properties.

4 Click the Paper/Quality tab (if available).

5 Click on the Advanced button.

6 Set the printer driver's resolution in the Graphic-Print Quality 
field. Choices are Low(200x100) and High(200x200).

Note: This changes the printer resolution for the whole system, and 
remains so until it is changed again, using the above procedure.

The Fine(300x300) and Ultra Fine(400x400) 
resolutions (when supported) can only be enabled by creating 
and modifying a registry key. Call your Interstar technical 
support representative, for more details.

7 Click OK.

8 Click OK.

9 Click Close.

10 Back in Word, click the  button.

SendFAX is launched and you are prompted to log on.

11 Address the fax.

You can add a profile or a cover sheet or make an entry to the Subject 
field.

12 Click Send.

E-Mail a TIFF File Using PrintToMail

PrintToMail is means of sending fax format (TIFF) files through e-mail 
software. The utility converts documents generated by third-party 
applications to the TIFF format and launches your default e-mail 
software with the file included as an attachment. A cover sheet, if you 
include one, is treated like any other attachment.

Note: Your recipient must have a viewer that displays TIFF files.
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E-Mail a TIFF File

1 Use the third-party application to write or open the document to be 
faxed.

2 Access the print options that allow you to select a printer.

3 Select the PrintToMail printer.

4 Print the document. PrintToMail launches your default e-mail 
software. The document is included as an attachment in TIFF format.

5 Address your recipient as you would any e-mail message. You can use 
any functionality your e-mail software provides.

6 Send the message.

Send a fax with a specific resolution

To send a fax using Print to Mail, with a specific resolution:

1 Use the third-party application to write or open the document to be 
faxed.

2 Access the printing properties dialog, usually from the File menu.

3 In the Select Printer section of the dialog, select the printer as 
Print to mail.

4 Click the Paper/Quality tab (if available).

5 Click on the Advanced button.

6 Set the printer driver's resolution in the Graphic-Print Quality 
field. Choices are Low(200x100) and High(200x200).

Note: This changes the printer resolution for the whole system, and 
remains so until it is changed again, using the above procedure.

The Fine(300x300) and Ultra Fine(400x400) 
resolutions (when supported) can only be enabled by creating 
and modifying a registry key. Call your Interstar technical 
support representative, for more details.

7 Depending on the application your are using, click the Print button, 
or exit the printer properties dialog and select Print in the File 
menu.

8 If the printer properties appears again, click OK to close it, as the 
properties are already set.

9 Terminate the fax composition in the email application.

10 Click Send.
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8 Introducing Phone Books

A phone book is a collection of contact lists, links and views, that 
stores contact information about recipients. You access the phone book 
in SendFAX to address faxes to the contacts recorded in the phone 
book.

LightningFAX provides a single un-populated phone book. It resides in 
the \Profiles\username\Application 
Data\lightningfax\LFclient\Phone folder in the Windows 
95/98/ME/NT versions. In Windows XP, 2000 and 2003, it resides in 
the \Documents and Settings\username\Application 
Data\Interstar Technologies\lightningfax\LFclient\Phone 
folder.

You can add phone books to that or any other directory. Phone book 
files have the .lfc extension. You can create as many phone books as 
needed. The contents of a phone book can be:

❑ defined as a contact list;

❑ imported into a contact list, from an external data source;

❑ linked to an external data source.

In the first two cases, the information actually resides within the 
phone book. Users can modify it whenever necessary. A phone book is 
composed of at least one contact list. A contact list is a list of potential 
fax recipients detailing their first name, last name, company name, 
and address, fax number, e-mail address, etc... A phone book can have 
any number of contact lists, however, only one contact list can be used 
at a time. A default contact list named Contact is generated when you 
create a new phone book.

In the third case, LightningFAX links to an external source; the 
information is displayed through the phone book, but cannot be 
modified using the phone book’s menus. If information linked to a 
phone book is to be changed or updated, users must update the 
external source using the software that created it.
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Finally, basic or advanced searches can be performed in a phone book. 
The results of these searches can be saved, thus creating views that can 
be consulted at a later time.

Note: These views are dynamic, so that any modification to a contact, if 
applicable, is automatically reflected in a view, the next time it is 
consulted.

Launching the Phone Book

❑ Choose Start ➡ Programs ➡ LightningFAX ➡ LightningFAX Tools 
➡ Phone Book.

❑ In the manager, choose Tools ➡ Phone Book.

❑ In SendFAX, choose Tools ➡ LightningFAX Phone Book. 

The default phone book or the phone book you last opened is 
automatically selected. Also selected automatically is the default 
contact list or the contact list you last chose in the phone book.
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The File Menu

New allows you to create a new phone book, a new contact list within an 
existing phone book, a new contact in a contact list, and a new group of 
contacts.

Open allows you to open an existing phone book.

Save As saves the current phone book under a new name.

Import imports data from an external data source to the current 
contact list.

Link creates a link between the current phone book and an external 
data source.

Link Fields allows you to update the links that match the fields of an 
external data source to the phone book’s internal fields.

Exit closes the phone book.

The Edit Menu

Properties displays the properties of a selected contact or group.

Delete deletes all selected items (contacts or groups).

Select All selects all contacts or groups in the currently displayed 
contact list.

The View Menu

Display Name switches the order in which names are displayed. You 
can choose First Name Last Name; Last Name First Name; or Last 
Name, First Name.

Toolbar displays or hides the toolbar at the top of the phone book 
window.

Status Bar displays or hides the status bar at the bottom of the phone 
book window.

The Tools Menu

Find Contacts performs a search for a contact.

Advanced Find performs a search for a contact and allows more 
complicated search criteria.

Contact List Management lets you rename or delete contact lists, 
links or views already present in the phone book.

Compact Database compacts the phone book database.
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Managing Phone Books

A phone book is composed of at least one contact list. A contact list is 
a list of potential fax recipients detailing their first name, last name, 
company name, and address, fax number, e-mail address, etc. A phone 
book can have any number of contact lists, however, only one contact 
list can be used at a time. A default contact list named Contact is 
generated when you create a new phone book.

In the phone book, contact lists are chosen using the Show Names from 
the drop-down list.

Clicking Full Name allows you to enter a title (Dr. Mr. Miss, Mrs., or 
Prof.) and first and last names. The title will appear as a salutation in 
the fax.

Additional information can be entered clicking the User Defined tab. 
Four user-defined fields and a comment field are provided.

The same menus and operations used to manage private phone books 
are used to manage public phone books. However, the contents are 
read-only for all users except administrators.

Open a Phone Book

1 In the phone book, choose File ➡ Open.

2 Select the phone book.

3 Click Open.

Add a Phone Book

1 In the phone book, choose File ➡ New ➡ Phone Book.

2 Type a name. The .lfc extension is automatically appended.

3 Click Save.

You can populate the default contact list with contacts and, optionally, 
with groups.

Add a Contact List

1 In the phone book, choose File ➡ New ➡ Contact List.

2 Type a name.

3 Click OK.

Delete a Contact List

1 In the phone book, choose Tools ➡ Contact List Management.

2 Select the contact list.

3 Click Delete.

4 Confirm deletion.

5 Click Close.
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Rename a Contact List

1 In the phone book, choose Tools ➡ Contact List Management.

2 Select the contact list.

3 Click Rename and type the new name.

4 Click Close.

Add a Contact

1 In the phone book, choose File ➡ New ➡ Contact.

2 Click Full Name to select a salutation and to enter a first and last name 
or position the cursor in the field and type the first and last name 
without a salutation.

No field in the contact information is mandatory. The phone book 
prompts for a first name when none is entered. However, you are not 
obliged to enter one. You can even create an empty contact for later 
completion.

3 Enter any other user information.

You can enter as many as three fax numbers and three e-mail 
addresses. The Preferred Address field allows you to select the one 
that SendFAX will use when several are specified.

Use the User Defined tab to enter additional information not defined 
by the fields available. For example, having entered the company 
address in the Address fields, you might wish to use the User 
Defined fields to enter a contact's personal address. You can also 
enter a comment through this tab.

4 Click OK.

Delete a Contact

Contacts are listed as individuals and as group members. Deleting an 
individual contact deletes that contact from any group they are 
members of.

1 In the phone book, select the contact.

2 Choose Edit ➡ Delete.

3 Confirm deletion.

Edit a Contact

1 In the phone book, select the contact.

2 Choose Edit ➡ Properties.

3 Enter the changes to the contact's properties.

4 Click OK.
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Compact the Database

1 In the phone book, choose Edit ➡ Compact Database.

2 Click OK.

Phone Book Groups

A group is composed of a number of individual contacts and, 
optionally, other groups. By selecting a group when faxing, you fax to 
all contacts in it. A contact list can include any number of groups.

The contacts you place in a group remain listed as independent 
contacts in the contact list. If you delete the group, the members 
remain available as independent contacts. If you delete them as 
individual contacts, however, they are also deleted from the group.

Add a Group

1 In the phone book, choose File ➡ New ➡ Group.

2 Type a name in the Name field.

3 Click Add New to add a contact not already in the phone book.

Click Select Members to add a contact or a group already in the 
phone book.

Use Remove to correct any errors.

4 Click OK.

Delete a Group

Contacts are listed as individuals and as group members. Deleting a 
group does not delete a contact’s individual listing.

1 In the phone book, select the group.

2 Choose Edit ➡ Delete.

3 Confirm deletion.

Add New Contact to a Group

1 In the phone book, select the group.

2 Click Edit ➡ Properties.

3 Click Add New.

4 Enter the contact information.

5 Click OK.

6 Click OK.
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Add Existing Contact/Group to a Group

1 In the phone book, select the group.

2 Choose Edit ➡ Properties.

3 Click Select Member.

4 Select a contact or a group. A group cannot be nested in itself.

5 Click .

6 Click OK.

7 Click OK.

Delete a Contact/Group from a Group

1 In the phone book, select the group.

2 Choose Edit ➡ Properties.

3 Select the contact or group.

4 Click Remove.

5 Click OK.

Phone Book Searches

The phone book offers a basic find and an advanced find. The basic 
find searches a single contact list or link, and specifies the exact 
entries you expect to find in information fields like First Name, Last 
Name and Fax Number.

An advanced find allows you to specify a far wider range of criteria. 
You can select any of the information fields available and specify 
several search criteria. Furthermore, an advanced find can specify 
more than one contact list or link.

Find a Contact

1 In the phone book, choose Tools ➡ Find Contacts.

2 The phone book offers Name, Company, Fax Number. and City as 
search criteria. Type the appropriate entries.

Use  to change City to State/Province or Country.

Select Save As and enter a name if the search is to be saved. Saved 
searches can be selected and run using Show Names from the. They 
are listed under the heading View.

3 Click Find Now.
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Use Advanced Find

1 In the phone book, choose Tools ➡ Advanced Find.

By default, the current contact list or link is selected. Use Browse to 
select or deselect contact lists and links.

2 Under New Criteria, use Field to select an information category.

3 Use Condition to select a condition type.

Condition types include contains, is exactly, begin with, 
doesn’t contain, is empty, and is not empty.

4 Under Value, type an entry that represents the expected results. The 
is empty and is not empty conditions require no Value entry.

5 Click Add to List.

You can specify one or more criteria. Use Remove to make any 
corrections.

6 Under Options, select Match any criteria when two or more 
criteria exist and any one fulfills the conditions of the search.

To apply every criteria to the search, select Match all criteria.

7 Select Save As and enter a name if the search is to be saved.

Saved searches can be selected and run using Show Names from the. 
They are listed under the heading View.

8 Click Find Now.

Phone Book Display

By default, a phone book displays contact information in three 
columns: Display Name, Company, and Fax Number. However, you can 
adjust the column headings to display any of the information fields 
available in the phone book.

You can select any column heading as the sort key. For example, the 
default sort key is Display Name, in ascending order. If you wish, you 
can select Fax Number, Company or any other displayed column 
heading as the sort key. Sort order can be ascending or descending.

Add a Column Heading

These changes affect all contact lists.

1 In the phone book, position the cursor over column bar at the location 
where the new heading is to be inserted.

2 Right-click and choose Insert Column.

3 Choose the column heading from the appropriate menu selection.

Delete a Column Heading

1 In phone book, position the cursor over the unwanted column heading.

2 Right-click and choose Remove This Column.
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Importing an External Data Source

External data sources can be imported into a phone book, as part of the 
current contact list. Once resident in the phone book, the contacts can 
be updated like any other contact.

External sources might be a worksheet in a spreadsheet or a table in a 
database that contains a list of names and fax numbers. By importing 
the source, you import the names and fax numbers into the current 
contact list.

The external source should be properly organized, with field names 
that correspond in meaning, if not in exact phrasing, to the 
information fields used by the phone book. For example, a field called 
Name in an external data source might include both first and last 
name. First Name and Last Name, however, are two distinct fields in 
the phone book. You may wish to update the external source before 
importing it.

You may need to assign fields being imported to the corresponding 
fields offered by the phone book. When field names match phone book 
names closely or exactly, LightningFAX automatically links the field in 
the external source to the corresponding phone book field. When field 
names do not correspond, you are given an opportunity to link them 
manually.

External Data Sources

Import an External Data Source

Although other external sources are available, this example imports 
information from a Microsoft Excel spreadsheet.

1 In the phone book, choose File ➡ Open to select the correct phone 
book

If necessary, use Show Names from the to select the correct contact 
list.

2 Choose File ➡ Import.

3 Use Select the format of your database to select Excel.

Click First Row Contains Field Name if the first row of the 
spreadsheet represents the field names or column headings.

❑ Borland® dBASE III, IV and 5 ❑  Phone Book

❑ Corel® Paradox ❑ Symantec® ACT!

❑ Microsoft® Access ❑ An ODBC-compliant data 
source

❑ Microsoft® Excel ❑ A comma separated value 
(.csv) text file. In a text file 
data source, the values are 
delimited by commas.
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4 Type the path and name of the file in the field provided. Alternatively, 
click Browse to navigate the file, select it, and click OK.

5 Click Next.

6 Select the worksheet that contains the contact information.

7 Click OK.

The phone book attempts to match corresponding fields. However, 
should field names in the external source not match, you must perform 
the link yourself by clicking in the right hand column where the phrase 
No Link appears. A pull-down list displays the phone book fields 
available.

Use AutoMatch to instruct the phone book to apply the most likely 
match. Use Reset to clear all matches and begin again.

8 Click Finish.

Linking to an External Data Source

External data sources can be linked to a phone book. A linked external 
source is always treated as a new and distinct contact list. 
LightningFAX uses the name of the table or worksheet as the name of 
the contact list. The name, which must be unique, can be changed 
either during the linking operation or afterwards through Edit ➡ 
Rename. It is subsequently displayed in the Contact List field.

You cannot link an external contact list into an existing contact list.

The contacts in a linked contact list cannot be edited or updated 
through LightningFAX. The phone book displays this information in 
read-only format. If contact information in a linked contact list is to be 
changed, you must update the source itself. Contacts in a linked 
contact list cannot be assigned to a group. Additional contacts cannot 
be added, individual contacts cannot be deleted directly through the 
LightningFAX Phone Book.

Because linking is dynamic, the changes you make to the contents of 
source are reflected in the linked contact list.

You can update the fields in a linked contact list. For example, if you 
add a new field to the source, or change the field name of an existing 
field in the source, it may be necessary to link it to a specific phone 
book field.
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Link to an External Data Source

Although other formats are available, this example imports 
information from a Microsoft Excel spreadsheet.

1 In the phone book, choose File ➡ Link.

2 Use Select the format of your database to select Excel.

3 Click First Row Contains Field Name if the first row of the 
spreadsheet represents the field names or column headings.

4 Type the path and name of the file in the field provided. Alternatively, 
click Browse to navigate the file, select it, and click OK.

5 Click Next.

6 Select the worksheet that contains the contact information.

7 Click OK.

The phone book attempts to match corresponding fields. However, 
should field names in the external source not match, you must perform 
the link yourself by clicking in the right hand column where the phrase 
No Link appears. A pull-down list displays the phone book fields 
available.

Use AutoMatch to instruct the phone book to apply the most likely 
match. Use Reset to clear all matches and begin again.

8 Click Finish.

Update a Linked External Source

1 In the phone book, use Contact List to select the linked contact list.

2 Choose File ➡ Linked Fields. The Set Link window appears.

3 Use the pull-down list by right-clicking the right hand column for the 
appropriate field.

4 Select the phone book field that best corresponds to the external field 
name.

5 Click Finish.

Reset sets all phone book fields to No Link. Reset might be used 
when a linked external source is greatly modified and a good many 
links must be manually assigned.
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9 Introducing the Viewer

The viewer lets you view the faxes you receive. Using the viewer, 
you can:

You can rotate fax pages if they were sent in the wrong orientation and 
change the viewer's display settings. A zoom setting decreases or 
increases the display size of the fax. The thumbnail view displays the 
individual pages of a multi-page fax in a vertical list.

You can e-mail the viewer as an attachment to whoever needs it. The 
file is named LFViewer.exe and resides in the Windows\Redist 
sub-folder of the LightningFAX CD.

❑ annotate a fax ❑ forward a fax to other members 
of the network

❑ e-mail a fax ❑ examine a fax’s routing history

❑ print a fax (including long 
faxes)

❑ create, save, and send a split fax

❑ save a copy on your PC ❑ update the original TIFF file 
stored on the server
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Launching the Viewer

❑ Choose Start ➡ Programs ➡ LightningFAX ➡ LightningFAX Tools 
➡ Viewer.

❑ Choose Tools ➡ Viewer in the manager menu.

❑ Double-click a fax displayed in the manager 

The File Menu

Open opens an TIFF existing file. The TIFF file format is used for faxes.

Print Fax sends the fax to a printer.

Send to ➡ Mail Recipient launches the default e-mail software; the 
fax in the viewer is automatically included as an e-mail attachment. 
Send To SendFAX launches SendFAX; the fax in the viewer is opened 
in SendFAX.

Save saves the fax with any modifications.

Save As saves a copy of the fax under a new name.

OCR launches the OCR program you have installed on your system.

OCR Settings lets you specify the path to your OCR executable. You 
can specify a path or use the browse button.

Exit closes the viewer.
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The View Menu

Main Toolbar toggles the display of the main toolbar.

Annotation Toolbar toggles the display of the annotation toolbar.

The Page Menu

First displays the first page of the fax in the viewer’s main view. This 
selection is not available when the first page occupies the main view.

Previous displays in the main view the page immediately before the 
one currently in the main view. This selection is not available when the 
first page occupies the main window.

Next displays in the main view the page immediately after the one 
currently displayed in the main view. This selection is not available 
when the last page occupies the main view.

Last displays the last page of the fax in the main view. This selection is 
not available when the last page occupies the main view.

Rotate Left rotates the page currently in the main view 90 degrees to 
the left. A page originally display in portrait orientation now appears 
in landscape.

Flip rotates the page currently display in the main view 180 degrees. 

Rotate Right rotates the page currently displayed in the main view 90 
degrees to the right.

Rotate All Left rotates all pages 90 degrees to the left.

Flip All rotates all pages 180 degrees.

Rotate All Right rotates all pages 90 degrees to the right.

Properties displays a window containing information such as the 
type of compression, the horizontal and vertical resolution, the type of 
resolution (high or low) and the size (horizontal and vertical), in 
pixels, of the fax.

Note: The type of resolution is also displayed on the status bar, at the 
lower right of the Viewer window.

The Fax Menu

Forward Fax displays a window through which you can forward the fax 
to other members of the network.

Routing Log displays a window containing information such as the 
date and time the fax was received, the user, group, or server that 
received it. The LightningFAX server automatically writes the 
information to a comments column in the window.

Neither selection is available if you launched the viewer as a 
independent utility and are not logged on to LightningFAX.

If you launched the viewer through the View selection offered by 
LightningFAX, you can open and forward any TIFF file to members of 
your network.
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The Zoom Menu

Zoom in selects the next display scale.

Zoom out selects the previous display scale.

Fit to height resizes the vertical height of the page to the view.

Fit to width resizes the horizontal width of the page to the view.

Best fit selects the best scale to fit the page to the view.

25% to 200% are pre-set scales. 100%, the default scale, is actual size.

Custom displays a window through which you can enter a zoom 
percentage.

The Annotation Menu

Annotations are selected by clicking the type of annotation desired, 
drawing a rectangle in the page displayed, and applying the annotation 
selected within the rectangle. All annotations can be resized and 
moved about the page.

Annotations are only described here. Annotations are detailed in 
Chapter 12 About Annotations. See Add Annotations on page 120. The 
operations described in that chapter are applicable in the viewer. 
Slight differences in operation are noted.

Show Annotations toggles the entry and the display of annotations in 
the page displayed. When it is not selected, annotations cannot be 
entered and existing annotations are not displayed.

Select is chosen after entering an annotation to cancel the annotation 
mode. For example, if you select Text or Line, you remain in text mode 
or line mode. Dragging the cursor a second time draws another text 
box or another line. Click Select to cancel the annotation mode.

Select mode also allows you to select existing annotations to resize, 
move, or delete them.

Text draws a text box on the currently displayed page. Type the text 
immediately after drawing the box. Text boxes can be resized by 
clicking them and dragging the handles.

Line draws a line on the page.

Rectangle draws a rectangle on the page.

Stamp displays a window through which you select a bitmap (.bmp) 
file. Select the .bmp file you wish and drag the cursor to form a 
rectangle. The selected .bmp graphic is written to the page.

LightningFAX offers three .bmp images: Approved, For Your 
Approval, and Please Sign and Return. You can use any others 
available. Like text boxes, bitmap stamps can be selected and resized.

Highliter lets you draw a rectangular rubber band over important text. 
Yellow highlight fills the rectangle.
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The Thumbnails Menu

Small displays a small version of the thumbnail, in the left panel of 
the viewer.

Medium displays a medium size version of the thumbnail, in the left 
panel of the viewer.

Large displays a large size version of the thumbnail, in the left panel 
of the viewer.

Open a Fax in the Viewer

1 Launch the viewer, and choose File ➡ Open.

2 Navigate to the file and select it.

3 Click Open.

These are alternative methods.

❑ Double-click a fax displayed in the manager.

❑ Right-click a fax displayed in the manager, select Show Details and 
click View in the Show Details window.

Note: Use either alternative if you intend to forward the fax from the 
viewer.

E-Mail a Fax through the Viewer

Note: Any annotations made prior to this procedure will be saved 
permanently.

1 Launch the viewer and open a TIFF file.

2 Choose File ➡ Send to ➡ Mail Recipient.

3 Address the e-mail.

4 Click Send.

Forward a Fax from the Viewer

Note: You can forward only the faxes in your LightningFAX message 
store. 

1 Double-click on the fax in the manager.

2 Choose Fax ➡ Forward Fax.
If necessary, use Group select a group.

3 Highlight a name in the User List. You can forward faxes only to 
other members of the network.

4 Click Add.
Use Add All to add all user names as recipients. To make any 
corrections, highlight a name in the Recipient List and use Remove. 
Use Remove All to remove all recipients.

5 Click Forward.
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Print a Fax from the Viewer

1 Launch the viewer and open a TIFF document.

2 Choose File ➡ Print Fax. You can change printers, enter the number 
of pages, etc.

3 Click OK.

Printing Long Faxes

In some cases, faxes can extend over multiple pages. The printing 
feature of the viewer can be tweaked, to determine how these faxes can 
be shrunk or cut into pieces, for optimal printing conditions.

To configure this setting, you need to change a registry key. For more 
details, contact your Interstar technical support representative.

Managing Viewer Display Settings

The viewer allows you to manipulate how faxes are displayed in a 
variety of ways.

Show or Hide Thumbnails

The thumbnail view displays fax pages in a vertical column on the left. 
By default, the thumbnail view in the viewer is closed.

❑ Click  in the viewer toolbar to toggle the display of the thumbnail 
view.

❑ Click any thumbnail to display the page in the main view.

By default, thumbnails are displayed in Small format. Right-clicking 
in the thumbnail panel at the left, offers a selection of Small, Medium 
or Large. Choose the size that you prefer.

Rotate or Flip Fax Pages in the Viewer

To rotate the page in the main view 
90 degrees to the left:

Choose Page ➡ Rotate Left

To rotate the page in the main view 
180 degrees:

Choose Page ➡ Flip

To rotate the page in the main view 
90 degrees to the right:

Choose Page ➡ Rotate Page 
Right

To rotate all pages 90 degrees to 
the left:

Choose Page ➡ Rotate All Left

To rotate all pages 180 degrees: Choose Page ➡ Flip All

To rotate all pages 90 degrees to 
the right:

Choose Page ➡ Rotate All Right
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Select a Fax Page in the Viewer

Change Display Size in the Viewer

25% to 200% are pre-set scales. 100%, the default scale, is actual size.

Custom displays a window through which you enter a zoom percentage.

Using OCR in the Viewer

If a program for optical character reading is available, you can enter its 
path and filename in the viewer. The functions available in the 
program can then be applied to a TIFF document opened in the viewer.

Select an OCR Program

1 In the viewer, choose File ➡ OCR.

2 Enter the path and file name of the OCR program.

3 Click OK.

Generate an OCR File

1 Launch the viewer and open a TIFF file or double-click on a fax in 
LightningFAX manager.

2 Choose File ➡ OCR.

3 Perform whatever OCR function the program makes available.

Note: The operations available will depend on the capabilities of your 
OCR program.

To display the first page of the fax 
in the main view:

Choose Page ➡ First

To display the previous page: Choose Page ➡ Previous

To display the next page: Choose Page ➡ Next

To display the last page: Choose Page ➡ Last

To select the next larger display 
scale:

Choose Zoom ➡ Zoom in

To select the previous display 
scale:

Choose Zoom ➡ Zoom out

To resize the fax to fit the vertical 
height of the main view:

Choose Zoom ➡ Fit to height

To resize the fax to fit the 
horizontal width of the main view:

Choose Zoom ➡ Fit to width

To select the best available scale: Choose Zoom ➡ Best fit
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About Saving TIFF Files

The faxes you access through the manager are actually stored in a 
database on the computer that acts as the server in the network. 
However, the viewer lets you save a local copy. If you have made 
modifications to a fax, for example, by adding annotations, you may 
wish to save a local copy on your computer's hard drive, leaving the 
original unmodified.

Alternatively, you can choose Save to overwrite the original.

Note: Saving a broadcast is not supported.

Save a Copy

Note: Any annotations made prior to this procedure will be saved 
permanently.

1 Launch the viewer and open a TIFF file or double-click on a fax in 
the manager.

Add any annotations you wish.

2 Choose File ➡ Save As.

3 Enter the name of your file. The .tif extension is automatically 
applied.

4 Click Save.

Save the Original

1 Double-click on a fax in the manager.

2 Add any annotations you wish.

3 Choose File ➡ Save.

Using the Routing Log

If the administrator has enable the routing log, you can display the 
information it contains about the fax in the viewer. The information 
includes the date and time the fax was received and the user, group, or 
server who sent it. These comments are automatically entered and 
appear in red. You can also enter your own comments. These appear in 
black. Both types of comments can be printed.

Note: The administrator must have enabled the routing log before any of 
the following operations can be successfully executed.

View the Routing Log

1 Double-click on a fax in the manager.

2 Choose Fax ➡ Routing Log.

3 Click Close to close the Routing Log window.
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Enter a Comment in the Routing Log

1 Double-click on a fax in the manager.

2 Choose Fax ➡ Routing Log.
3 Click Insert New Comment.
4 Enter the comment and press Return.

You can enter as many comments as you wish by clicking Insert 
New Comment.

5 Click Close to close the Routing Log window.

Print the Routing Log

1 Double-click on a fax in the manager.

2 Choose Fax ➡ Routing Log.

3 Click Insert New Comment to add a comment.

4 Click Print Routing Log to send a copy of the routing log to a printer.

5 Click Close to close the Routing Log Information window.
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10 Introducing the
Cover Sheet Editor

Use the cover sheet editor to design new or redesign existing cover 
sheets. You can import graphics and bitmap (.bmp) images; add text, 
lines and shapes; or customize any of the ten cover sheets included 
with LightningFAX.

Use the cover sheet editor:

❑ to create, import, and link to OLE 2.0–compatible objects within the 
cover sheet editor

❑ to draw lines, squares, rectangles, circles, and polygons

❑ to add text and bitmap (.bmp) images

❑ to add variables that automatically insert such information as sender 
name and company, etc.

Note: In cover sheet editor documentation, the terms item or items refer 
to text, lines and shapes, variables, bitmap graphics, and OLE 2.0 
compatible objects. The terms object or objects refer only to OLE 
2.0 compatible objects.

A wire frame surrounds the items placed in a cover sheet. All items can 
be selected with the mouse and edited, deleted, or moved.

Stand-alone fax machines usually have a lower resolution than laser 
printers. Your cover sheets may have a slightly coarse appearance 
when printed by a fax machine.

Note: The LightningFAX administrator can chose not to install the cover 
sheet editor on users’ computers.
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Launch the Cover Sheet Editor

❑ Choose Start ➡ Programs ➡ LightningFAX ➡ LightningFAX 
Tools ➡ Cover Sheet Editor.

❑ Choose Tools ➡ Cover Sheet Editor in LightningFAX manager. 
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The File Menu

New allows you to create a new cover sheet.

Open opens a previously saved cover sheet.

Save saves the current cover sheet.

Save As saves your current cover sheet under a different name or in a 
different location.

Print prints the current cover sheet.

Print Preview displays cover sheet as it will look when printed.

Print Setup sets print options.

Exit closes the cover sheet editor.

The Edit Menu

Undo erases the last action.

Cut removes the selected object or objects and copies them to the 
Windows clipboard. The objects can then be pasted back on the same 
page or on another page using the Paste command.

Copy copies the selected object or objects to the clipboard without 
removing them. The objects can then be pasted back on the same page 
or on another page using the Paste command.

Paste copies the contents of the clipboard to your cover sheet. You can 
then paste it as often as needed.

Delete erases selected objects.

Insert New Object lets you create, import and link to graphics, text, 
spreadsheets, wave sounds, etc., created with other applications. 
Those applications must be installed to enable object creation.

If the cover sheet is linked to any OLE 2.0–compatible objects, the 
Links menu selection allows you to edit and update those links. This 
menu selection is not available if there are no linked objects in the 
cover sheet.

Bitmap Image Object offers a submenu with Edit, Open, and Convert 
menu selections. Edit lets you edit a highlighted bitmap using the 
editor’s tools. Open opens the image in the application that created it. 
Convert saves the image to another file format.

The text of this last menu selection will vary according to the object selected in 
the cover sheet. For example, if you have selected a linked CorelDraw object, 
the phrase Linked CorelDraw Object appears instead of Bitmap Image 
Object. The subordinate menu selections, Edit, Open, and Convert remain 
unchanged.
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The View Menu

Toolbars displays the main toolbar, the drawing toolbar, and the text 
attributes toolbar.

Status Bar enables or disables the status bar at the bottom of the 
cover sheet editor window.

Grid toggles the display of the grid points on the page.

Zoom Settings lets you choose a different magnification setting to 
view your pages. By default, the page is displayed at 100%, its actual 
size.

The Variables Menu

There are three categories of variables used in cover sheets: General, 
Sender and Recipient. These variables are automatically filled in by 
LightningFAX at the time of your fax transmission.

The Settings Menu

Page Setup lets you chose the page size of the cover sheet: Letter, 
Legal, A3, B3 or A4, or view the page dimensions by inches, pixels 
or millimeters.

The Refresh Menu

The Refresh menu refreshes the cover sheet.

Cover Sheet Variables

There are three categories of variables used in cover sheet: General, 
Sender and Recipient. These variables are automatically filled in by 
LightningFAX at the time of your fax transmission.

General variables include:

Sender variables include:

Sender information is defined in the fax sender's Information 
property.

Time Number of Pages Commentary API Tag 2

Date Subject API Tag

Dear Street Phone Billing Code

Display Name City Fax Sub Billing Code

First Name State/Province Cellular

Last Name Country Pager

Company Zip Code E-mail

Title
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Recipient variables are arranged in four categories.

Recipient information is defined in the LightningFAX Phone Book. 
The menu selection Dear receives the value entered in the Salutation 
field in the Phone Book.

OLE 2.0 Compatible Objects

Because the cover sheet editor is OLE 2.0 compatible, you can create, 
embed, or link to any OLE 2.0 compatible object created with a wide 
variety of third-party applications.

When you create a new object, the application that generates it is 
launched within the cover sheet editor. That application’s menus, 
toolbars, and status bar are integrated into the cover sheet editor 
window. An application window allows you to perform the necessary 
operations. Clicking outside the window, but within the cover sheet, 
closes the application.

Among many others, objects placed in a cover sheet can be CorelDraw 
and Corel PhotoPaint graphics, Microsoft Paint graphics, Microsoft 
PowerPoint slides, Word and WordPerfect documents, wave sounds, 
and video clips.

The application to generate the desired object type must be accessible 
from the computer running the cover sheet editor.

Embedding and Linking Objects

To embed an object is to place it in the cover sheet much like any other 
item such as text or a variable. However, an embedded object can be 
updated from within the cover sheet editor; when you do, the original 
application is launched within the cover sheet editor.

To link to an object is to reference it from the cover sheet without 
physically embedding it in the cover sheet. Changes made to the linked 
object, using the application that created it, are automatically reflected 
in the cover sheet.

Name Address Destination Other

Dear Street Destination Phone

Display Name City Fax Extension

Last Name State/Province Fax 2 Cellular

First Name Zip Code Fax 3 Pager

Company Country E-mail Billing Code

Title E-mail 2 Sub Billing Code

E-mail 3 Phone Book Commentary

User 1

User 2

User 3

User 4
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Managing Linked Objects in a Cover Sheet

By default, linked objects in a cover sheet are updated automatically. 
When the object is changed through the application that created it, 
those changes are reflected immediately and automatically in the cover 
sheet. However, updating can be made manual. When manual updating 
is selected, the object remains as it was when you originally linked to 
it. Changes made to the object are ignored.

For example, a logo already used as a linked object in a cover sheet is 
to be modified. You might change the update from automatic to 
manual while these changes are being made. When the modifications 
are finished, you have the option of returning to automatic updating or 
updating manually in anticipation of further changes.

You can also launch the application to edit to linked object directly, 
break the link, and change the object. Breaking the link embeds the 
object. Changing the object links to another object.

Editing and Converting Objects

When an object created by another application is selected in the cover 
sheet editor, you can edit it by launching the application that created 
it. If the object was imported, the application can be launched within 
the cover sheet editor or as an independent program. If the object was 
linked, the application is always launched independently.

If the formats are supported, you can also convert the object to another 
format.

Create a Cover Sheet

1 Open the cover sheet editor.

2 Add text, a line or shape, graphic images, variables and OLE 2.0 
compatible objects. Users can import or link to an OLE 2.0 compatible 
object.

3 Choose Save As and type a name. The .cse extension is 
automatically applied.

Add Text

Text formatting includes bold, italic, and underline; typeface and size; 
flush-left, flush-right, and centered.

1 Click .

2 Draw a text box.

3 Type the text.

4 Click outside the text box.

Note: When any text box is selected, clicking  undoes the last edit 
that was made on its content. Clicking it again restores the 
modifications.
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Add Lines and Shapes

1 Click  to add a line.

Click  to add a rectangle or square.

Click  to add a rectangle or square with rounded corners.

Click  to add a circle or ellipse.

2 Drag a box at the location you want the object to appear.

3 Release the mouse button.

Add a Polygon

1 Click  to add a polygon.

2 Position the cursor.

3 Click once and move the cursor to the next corner.

Repeat step 2 as often as required.

4 Double-click to cancel polygon entry.

Add Variables

1 Chose Variables.

2 Choose a General, a Sender or a Recipient variable.

3 Drag a box at the location you want the variable to appear.

4 Release the mouse button.

Add an Object

The cover sheet editor enables you to insert the content of a file as an 
object, so that you may edit it at any time, using the application that 
was used to create it.

1 Choose Edit ➡ Insert New Object or click .

2 Select the Create from File option.

If necessary, click Browse to navigate to the file.

Select the Display as Icon option if you wish the object to appear as 
an icon in the cover sheet.

3 Select the file and click Open.

4 Click OK.

LightningFAX imports the object into the cover sheet. It may be 
necessary to move the object or to change its size.
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Create an Object

The cover sheet editor also enables you to create a new object and 
choose the application that you wish to use.

1 Choose Edit ➡ Insert New Object or click .

2 Select the Create New option.

3 Choose an application from the list.

4 Click OK.

The application is launched within the cover sheet editor. Note that 
application's menu selections, and its toolbar and status bar are made 
available. You can resize the application’s window if necessary.

5 Perform whatever operations are required to create the object.

6 Click outside the object but within the cover sheet.

The application is closed, leaving the object you created. It may be 
necessary to move or resize the object.

Link to an Object

1 Choose Edit ➡ Insert New Object or click .

2 Select the Create from File option.

3 Select the Link option.

If necessary, click Browse to navigate to the file.

Select the Display as Icon option if you wish the object to appear as 
an icon in the cover sheet.

4 Select the file and click Open.

5 Click OK.

LightningFAX imports the object into the cover sheet. It may be 
necessary to move the object or to change its size.

Change a Link to Manual Update

1 Select a linked object.

2 Choose Edit ➡ Links.

3 Choose the Manual option.

If necessary, use Cancel to cancel an unwanted operation.

4 Click Close.

Manually Update a Link to an Object

1 Select a linked object.

2 Choose Edit ➡ Links.

3 Click Update Now.

If necessary, use Cancel to cancel an unwanted operation.

4 Click Close.
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Break a Link to an Object

1 Select a linked object.

2 Choose Edit ➡ Links.

3 Click Break Link.

4 Click Close.

Update an Object

1 Select an object.

2 Choose Edit ➡ application type Object.

This menu selection is the last in the Edit menu. Its exact name will 
change according to the type of object selected. If a bitmap image is 
selected, for example, the menu selection will be Bitmap Image 
Object. If the object selected is linked to the cover sheet, the work 
Linked will appear before the name of the application type.

3 Choose Edit to launch the original application inside the cover sheet 
editor.

Alternatively, choose Open to launch the original application as an 
independent program.

If the object is linked to the cover sheet, the application is always 
launched as an independent program.

4 Make whatever updates you need.

5 When finished, click outside the application if you launched the 
application inside the cover sheet editor.

6 When finished save your changes and choose File ➡ Exit in the 
application, if you launched the application as an independent 
program.

Update a Linked Object in a Cover Sheet

The following is an alternative method of updating linked objects.

1 Select a linked object.

2 Choose Edit ➡ Links.

3 Choose Open Source.

The original application is launched as an independent program.

4 Make whatever changes you need.

If necessary, use Cancel to cancel an unwanted operation.

5 Choose File ➡ Save in the application.

Convert an Object

1 Select the object.

2 Choose Edit ➡ application type Object ➡ Convert.

3 Select the target format for conversion in the Convert window.

Only the compatible conversion formats will be available. For example, 
a bitmap image created with Microsoft Paint can be converted to a 
Picture (Device Independent Image) Bitmap.

4 Click OK.
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Edit an Item in a Cover Sheet

1 Select the item.

2 Choose Edit ➡ Cut to remove the item to the clipboard.

Choose Edit ➡ Copy to copy the item to the clipboard.

Choose Edit ➡ Paste to paste the item from the clipboard to the cover 
sheet.

3 If necessary, use Edit ➡ Undo to undo an unwanted change.

Delete an Object from a Cover Sheet

1 Select the item.

2 Choose Edit ➡ Delete.

Print a Cover Sheet

1 Open a cover sheet.

2 Choose File ➡ Print.

Change whatever print options you wish.

3 Click OK.

Preview a Cover Sheet

1 Open a cover sheet.

2 Choose File ➡ Print Preview.

3 Choose Close.

Change Cover Sheet Display Settings

Change Cover Sheet Zoom Settings and Page Display

Cover sheet zoom settings are available in magnifications of 200, 100, 
50, and 25 per cent. The default is 100 per cent.

To toggle display of toolbars 
in the cover sheet editor:

Choose View ➡ Toolbars ➡ Main Toolbar

Choose View ➡ Toolbars ➡ Drawing 
Toolbar

Choose View ➡ Toolbars ➡ Text 
Attributes Toolbar

To toggle the display of the 
status bar:

Choose View ➡ Status Bar

To toggle the display of 
the grid:

Choose View ➡ Grid

To select a higher zoom 
setting:

Choose View ➡ Zoom Settings ➡ Zoom In

To select a lower zoom 
setting:

Choose View ➡ Zoom Settings ➡ Zoom Out
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Change Cover Sheet Page Display

Change Cover Sheet Page Size

Users can select Letter, Legal, A3, B3 and A4 page sizes. You can 
also display page size in Inches, Pixels or Millimeters.

1 Choose Settings ➡ Page Setup in the cover sheet editor.

Select a measure, if required.

Select a measure of Inches, Pixels or Millimeters; if required.

2 Select a paper size.

To view the entire page: Choose View ➡ Zoom Settings ➡ Fit 
Entire Page

To fit to page width: Choose View ➡ Zoom Settings ➡ Fit Page 
Width

To fit to page height: Choose View ➡ Zoom Settings ➡ Fit Page 
Height
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11 Introducing Profiles

A profile can contain a fax header, reference a cover sheet, and contain 
sender information. A profile can also specify a Call Station ID (CSID), 
a callback number (CBN), a prefix, a suffix, the number of retries, the 
fax priority, and sender billing information. A profile can be associated 
with a resource or make use of least cost routing and load balancing. If 
a profile is to make use of least cost routing and load balancing, an 
LCR network must be configured.

Profiles are saved and can be applied through SendFAX or the Forms 
for Microsoft® Outlook.

Profiles serve a variety of needs.

❑ Administrators can use a profile to specify once the company 
information that otherwise would be specified repeatedly in the user 
properties of each user.

❑ Creating several profiles, each with different sender information, 
allows a user to send faxes on behalf of others.

❑ An individual user might use profiles to consistently apply a particular 
fax header and cover sheet to their faxes. For example, a user might 
create one cover sheet for intra-office and another for external 
communications. One profile references the first, another references 
the second.

❑ Several otherwise identical profiles might each reference a different 
cover sheet, each cover sheet containing the same information, but in a 
different language.

Note: A profile must be used if sender billing information is to be saved 
with fax sender information.
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Launching the Profile Manager

❑ Choose Tools ➡ Profile Management in the manager or in SendFAX.

Types of Profiles

Profiles may be:

❑ private, created and used by an individual user

❑ public, created by an administrator and available to all users

❑ group, created by an administrator and associated with a group

Overlooking its other functions, a public profile provides a means of 
specifying corporate information once rather than repeatedly in the 
User Properties of every user. Such information would include 
company name and address, telephone and fax numbers, Call Station 
ID, callback number, etc. This information, entered in a public profile, 
overrides the same information entered in a user's Properties.

A group profile serves the same purpose for groups.

Only administrators can edit public or group profiles. All users can 
create private profiles. Private profiles are available only to those who 
create them.

LightningFAX Default Profile

LightningFAX provides a default profile, which uses the name 
Default. It references the default cover sheet, also named Default; is 
associated with Resource 1, provides for three retries and sets a fax 
priority of three. All other information is blank. You can use this as 
your default profile, or use it as the basis for other profiles.

Default Profiles

Any profile can be declared the default, and there may be a default 
profile of each type. When this is the case, LightningFAX automatically 
applies first the default public profile. If no default public profile 
exists, LightningFAX applies the default group profile. If that does not 
exist, it applies the default private profile.

When sending a fax, however, users can select any profile available to 
them. For example, although a default group profile exists, a user in 
the group can choose their private profile.
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Sender Information

Sender information in public and group profiles includes:

Sender information in private profiles includes the above and the 
following:

Profiles can also include a fax header and reference a cover sheet.

Associating a Profile with a LightningFAX Resource

A profile can be associated with a resource. A profile would be 
associated with a resource when faxes are transmitted through any one 
of several resources. The profile would be applied when a fax is 
transmitted through the associated resource.

If least cost routing (LCR) and load balancing have been configured, 
the profile can instruct LightningFAX to use LCR when transmitting 
faxes.

About Billing Codes

Administrative procedures sometimes require that billing information 
be associated with a fax transmission. For example, long distance costs 
may be charged to specific departments within a company. A sender 
billing code can be specified to identify the department. Similarly, a 
recipient billing code might be assigned when clients are to be charged 
such costs.

Billing information consists of a billing and a sub-billing code for both 
sender and recipient. Using billing and sub-billing codes together can 
provide a greater degree of precision. For example, a billing code 
might identify a particular department in a national corporation; 
several different sub-billing codes might each identify that 
department’s regional offices.

Sender billing information is usually specified in a profile, although 
this is not mandatory. If no profile is being used, or if the profile being 
used with SendFAX does not contain billing information, the fax 
sender can enter it by accessing their sender information.

Sender billing information can be stored only in a private profile.

Recipient billing information is usually specified in the recipient’s 
entry in a phone book. Again, this is not mandatory. Fax senders can 
enter recipient billing information by accessing the fax recipient’s 
properties when using SendFAX.

Company Street City State Country

Zip Code Phone Fax Call Station ID (CSID) Callback Number (CBN)

Prefix Suffix

Salutation First Name Last Name Job Title Email

Cellular Pager Billing Code Sub Billing Code
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Enforcing Billing Code Entry and Validation

Fax senders can enter billing information, whether sender or recipient, 
at their discretion. However, administrators can enforce the entry of 
billing codes.

The following diagram outlines SendFAX operation when the entry of 
sender billing information is enforced.

The following diagram outlines SendFAX operation when the entry of 
recipient billing information is enforced.

Billing Code Validation

Billing information is validated by entries made to either or both of 
two files: sbilling.dat and rbilling.dat. The first file validates 
sender billing information; the second, recipient information. Both 
files must be stored in the \Program Files\LightningFAX\LFServer 
folder. Both are ASCII files composed with any text editor.

1

Transmit

2

SendFAX prompts you to enter the
billing information when you click Send.

Yes

Yes

No

No

1 Does the profile you are 
using include your billing 
information?

2 Did you enter your sender
billing information in your
sender information in 
SendFAX?

1

2

Place recipient in
Fax Recipient List

Place recipient in
Fax Recipient List as
canceled recipient

SendFAX places the recipient in Fax Recipient List as canceled recipient
and prompts you for billing information when you reject cancellation

Yes

Yes

No

No

1 Does the fax recipient’s
phone book entry include 
their recipient billing 
information?

2 Did you enter the recipient 
billing information in the fax 
recipient’s property sheet?
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The syntax of entries in these files is 
billingcode,[sub-billingcode], where both entries are any 
alphanumeric string. For example, abcindustries, represents the 
billing code alone; abcindustries,dept12 represents a billing and a 
sub-billing code. Wildcards can be specified. The question mark, ?, 
represents any single alphanumeric character; the asterisk (*) 
represents any number of alphanumeric characters.

Note: Although a sub-billing code is optional, the comma must be 
entered.

Create a Profile

1 In the profile manager, click New.

2 Type a name in Profile Name. An optional description can be entered 
in the Description field.

If desired, use Copy Profile Settings From to select an existing 
profile as the basis for the new profile.

Administrators can specify the type of profile: Public, Private, or 
Group. The default is private. Users create only private profiles.

To create a group profile, select For Group and select the group.

3 Click OK. The Editing Profile window is displayed.

To add a fax header, select Use Fax Header. You can edit fax header 
information by clicking Edit Fax Header.

To include a cover sheet, select Use Cover Sheet. Click  and select 
a cover sheet. Only a LightningFAX cover sheet with the .cse 
extension can be selected.
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4 Type the sender information. Sender information in a profile overrides 
the corresponding information in user and group properties.

If required, select a particular resource. Only those resources 
configured for use when LightningFAX was installed will be available.

If least cost routing has been configured, administrators can instruct 
LightningFAX to use it by selecting the Use LCR option.

To make the profile a default, select Set this profile as default.

If desired, change the number of retries. The default is three. The 
maximum is 99.

If desired, change the fax priority. The default is three. Fax priority 
ranges from 1, the highest, to 10, the lowest.

If a sender billing code or both a billing code and a sub-billing code is 
to accompany the faxes sent using the profile, type them in Billing 
Code and Sub-Billing Code.

5 Click OK.

Edit a Profile

1 In the profile manager, select the profile. Only administrators can edit 
public and group profiles.

2 Click Edit.

3 Enter whatever changes are necessary.

4 Click OK.

Rename a Profile

1 In the profile manager, select the profile.

2 Click Rename.

3 Type the new name.

4 Click OK.

Delete a Profile

1 In the profile manager, select the profile.

2 Click Delete.

3 Confirm deletion.
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12 About Annotations

Annotations can be added to a document in SendFAX and a TIFF file 
opened in the viewer.

Annotations are added by selecting the type of annotation, drawing a 
rectangle in the page displayed, and applying the annotation selected 
within the rectangle. All annotations can be resized and moved about 
the page. Annotations can also be formatted. Color and thickness can 
be assigned to lines and rectangles; color, font, and size can be 
assigned to text.

Annotations added in SendFAX are not permanent. They are 
superimposed on the page in the Fax Preview page and incorporated in 
TIFF file SendFAX generates when you transmit the document. The 
original document remains unchanged. Annotations added in the 
viewer are saved if you save the TIFF file. The next time you open that 
document in the viewer, the annotations will be present. You can then 
modify them as necessary.

In both SendFAX and the viewer, annotations are accessed through the 
Annotation menu selection.

Annotation Types

There are five types of annotations:

Text draws a text box on the currently displayed page. Type the text 
immediately after drawing the box. Text boxes can be resized by 
clicking them and dragging the handles.

Line draws a line on the page.

Rectangle draws a rectangle on the page.
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Stamp displays a window through which you select a bitmap (.bmp) 
file. Select the bitmap file you wish and drag the cursor to form a 
rectangle. The selected bitmap graphic is written to the page.

LightningFAX offers three bitmap images: Approved, For Your 
Approval, and Please Sign and Return. You can use any others 
available. Like any annotation, bitmap stamps can be selected and 
resized.

Highlighter draws a rectangular, yellow colored rubber band. Use it to 
highlight important text.

Show and Hide Annotations

❑ In SendFAX or the viewer, choose Annotation ➡ Show Annotation 
to toggle the display of annotations.

Add Annotations

1 In SendFAX, choose Annotation ➡ Add ➡ Text, Line, Rectangle, 
or Highlighter., In the viewer, choose Annotation ➡ Text, Line, 
Rectangle, or Highlighter.

2 Position the cursor at the desired starting point.

3 Drag the cursor to the desired end point and release the mouse. If you 
drew a text box, type the text.

4 In SendFAX, click  in the Annotation toolbar to cancel the 

annotation type. In the viewer, click ., You must cancel the 
annotation type to perform any other operations.

Add a Bitmap (.bmp) Annotation

1 In SendFAX, choose Annotation ➡ Add ➡ Stamp.

In the viewer, choose Annotation ➡ Stamp.

A window displays the three bitmap files provided with SendFAX. The 
text of each bitmap file is indicated by its filename: Approved, For 
Your Approval, and Please Sign and Return.

2 Select any one of these three or navigate to another directory to select 
another bitmap.

3 Click Open.

In SendFAX, the bitmap is automatically positioned at the top left of 
the page. Move or resize it as necessary.

In the viewer, drag the cursor to enter the bitmap. 
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Delete an Annotation

1 In SendFAX, select the annotation and choose Annotation ➡ 
Delete., In the viewer, select the annotation, right-click and choose 
Delete.

2 Confirm deletion.

Move and Resize Annotations

1 Select the annotation.

2 Click once. Eight resizing handles appear on the perimeter of text 
boxes, rectangles, and highlight. Two handles appear at each end of a 
line.

3 Move the annotation by dragging it., Resize the annotation by dragging 
its handles.

Edit Text Annotations

1 In SendFAX, position the cursor over the text box and double-click., In 
the viewer, position the cursor over the text box, right-click, and 
choose Properties.

2 Enter the changes.

3 In SendFAX, click anywhere outside the text box., In the Viewer, click 
OK.

Format Annotations

Format properties for lines and rectangles include thickness and color. 
Format properties for text include foreground and background color; 
font and type size; bold, italic, and underline.

Note: Formatting cannot be applied to bitmap images.

1 Select a line, rectangle, or text box.

2 In SendFAX, choose Annotation ➡ Properties., In the viewer, 
right-click and choose Properties.

3 Assign the properties you wish.

4 Click OK.
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13 Introducing Fax Headers

A fax header is a line of text printed at the top of each page sent. 
LightningFAX makes available a large number of variables — Day, 
Month, Year, etc — that can be included in a fax header. Text can also 
be specified.

Some variables, like Month, Time, and Fax Number, are resolved by the 
system. Others, like Company, CSID, and Sender Phone Number, are 
resolved by entries made to a user’s or group’s Information property. If 
no information is entered there, the variable in the fax header will 
contain no information.

Fax headers can be specified (a) in a profile, (b) for an individual user, 
(c) for a group, and (d) for a resource. That is the order of precedence 
when a fax header is specified at more than one level. For example, a 
fax header specified in a profile overrides a fax header specified for an 
individual user, and so on.

Default Fax Header

After initial installation of LightningFAX, a default fax header is 
already associated with resource 1. This fax header includes:

❑ the date in Year, Month, and Day

❑ time in Hour, Minute, and Seconds

❑ a Call Station ID (CSID)

❑ a callback number (CBN)

❑ the word Page followed by page number and total number of pages



Chapter 13 Introducing Fax Headers

124 LightningFAX User Guide

This fax header may be modified or deleted, as required.

Add Fax Header to a Resource

Note: Only administrators add fax headers to resources.

1 Select the resource in the manager.

2 Choose Edit ➡ Properties or right-click and choose 
Resource Properties.

3 Click Fax Header.

4 Compose the fax header.

Add Fax Header for a Group or User

1 Select a group or user in the manager.

2 Right-click and choose Group Properties or User Properties.

Note: Only administrators add fax headers to groups.

3 Select the Fax Settings tab.

4 Under Settings, select Use these settings if it is not already 
selected.

5 Click Edit Fax Header.

6 Compose the fax header.

Add Fax Header to a Profile

1 In the manager, choose Tools ➡ Profile Management to create a new 
profile or edit an existing one.

2 Select Use Fax Header.

3 Click Edit Fax Header.

4 Compose the fax header.
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Add Fax Header in SendFAX

1 Choose Edit ➡ Transmission Settings or click .

2 Click Edit Fax Header.

3 Compose the fax header.

Delete a Fax Header

1 Open an existing fax header.

2 Click Add Variable.

3 Select No Fax Header.

4 Click OK and confirm deletion.

5 Click OK.

Compose or Edit Fax Headers

Note: Fax headers can be no more than 95 characters long.

Add a Variable

1 Add or open a fax header.

2 Click Add Variable.

3 Select the variable from the list.

The Variable Number field identifies the variable.

The Maximum Characters field indicates the longest entry possible. 
For example, the Sender Company variable allows for a maximum of 
47 characters.

The Characters Used field specifies how many of the available 
characters are to be used. For example, if the company name uses 11 
characters, you might wish to type 12 in Characters Used; using 11 
characters for the name with an extra character for the space before 
the next variable.

If you do not make an entry to Characters Used, the maximum 
characters are used.

Some variables such as Hour, Minute, and Second must use their 
maximum number of characters. That is, you cannot specify fewer 
characters than the maximum indicated.

The Sample field offers a example of the variable selected.

4 Click OK.

Add Text

1 Add or open a fax header.

1 Click Add Text.

2 Type the text. Blank space can be entered by pressing the spacebar.

3 Click OK.

Your text is placed in the list, with quotation marks added 
automatically.
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Edit a Variable or Text

1 Open or add a fax header.

2 Select a variable or the text already entered in the fax header.

3 Click Edit.

4 Make the changes you want.

5 Click OK.

Delete a Variable or Text

1 Select the variable or text already entered in the fax header.

2 Click Delete.

3 Click OK.

Reorder Variables and Text

1 Select the variable or text already entered in the fax header.

2 Use Move Up to raise the variable or text one place in the list. Use Move 
Down to lower the variable or text one place in the list.

3 Click OK.
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14 Introducing
LightningFAX

Mail Gateways

LightningFAX mail gateways are a means of sending and receiving 
faxes without using SendFAX. Most frequently, a gateway is installed 
as an alternative to installing and using the manager, SendFAX, and 
the various tools and utilities that accompany those products.

If a gateway is installed, it is probable that your administrator wishes 
that you send and receive faxes through your e-mail software rather 
than through SendFAX. Indeed, it is probable that SendFAX isn’t 
installed on your computer.

The gateways include:

Note: The gateway for SMTP provides faxing functionality for such 
e-mail software as Microsoft Outlook Express, Netscape 
Communicator, Eudora, etc. If you are using any of these 
products, see See Faxing through the SMTP Gateway on page 131. 
to learn how to send faxes.

❑ Gateway for Microsoft 
Exchange

❑ Gateway for Simple Mail 
Transfer Protocol (SMTP)

❑ Gateway for R/3
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LightningFAX Addressing Format

No matter what mail gateway is used to transmit faxes, XMediusFAX 
provides a way of specifying per-recipient properties.

The recipient address can be formatted using key=value pairs, that 
provide extra information. Each pair must be separated by a forward 
slash "/".

Spaces can appear in the values, for example: fn=John Doe.

Here are the keys available:

These can be used with all LightningFAX gateways. However, each 
gateway has a slightly different way of addressing recipients. Examples 
are presented in the following sections, according to the gateway 
described. See also About Distribution Lists on page 133 for 
information on distribution lists.

About the Gateway for Microsoft Exchange

If the gateway for Microsoft® Exchange is installed in the network, 
users can fax with Microsoft Outlook. Fax recipients can be added to 
the personal address book (with Exchange 5.5 only; not available with 
Exchange 2000) and a distribution list of fax recipients can be created. 
Nothing prevents users from transmitting a same message to both 
e-mail and fax recipients at the same time.

Note: The forms for Microsoft Outlook should not be confused with the 
gateway for Microsoft Exchange. The gateway and the forms work 
together but serve different purposes.

The gateway submits outgoing faxes, generated from mail 
messages, to the fax server, and processes mail notifcations 
triggered by the fax server.

The forms for Microsoft Outlook are simply an extended graphical 
user interface designed for the manipulation of mail messages 
sent to and received from the gateway.

Incoming faxes are managed as incoming e-mail messages are 
managed.

dear fax

first or fn (first name) pager

last or n (last name) cellular

address company or co

city email

state jobtitle

zipcode distlist

country billingcode or bc

phone subbillingcode or sbc
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Add Recipients to Microsoft Outlook Address Book 1 (Exchange 5.5 Only)

1 Launch Outlook.

2 Choose Tools ➡ Address Book.

3 Choose File ➡ New Entry.

4 Select the LightningFAX Address tab.

5 Click OK. The New LightningFAX Address Properties window is 
displayed.

6 Type a Display Name and Fax number.

7 Additional information can be entered in the Business, Phone 
Numbers, and Notes tabs.

8 Click OK.

Add Recipients to Microsoft Outlook Address Book 2 (Exchange 5.5 Only)

1 Launch Outlook.

2 Choose File ➡ New ➡ Mail Message.

3 Choose Tools ➡ Address Book or click To in the Message window.

4 Click New in the Select Names window.

5 Select the LightningFAX Address tab.

6 Click OK.

7 Type a Display Name and a Fax number.

Additional information can be entered in the Business, Phone 
Numbers, and Notes tabs.

8 Click OK.

Specify Notification Options for Microsoft Outlook (Exchange 5.5 Only)

1 Launch Outlook.

2 Choose File ➡ New ➡ Mail Message.

3 Choose File ➡ Properties.

4 Click Send Options.

5 Select the Fax Options tab.

Under Notify Sent, select Yes to enable notification of 
successful transmission.

Under Notify Failed, select Yes to enable notification of 
failed transmission.

6 Click OK.
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Specify a Cover Sheet for Microsoft Outlook (Exchange 5.5 Only)

1 Launch Outlook.

2 Choose File ➡ New ➡ Mail Message.

3 Choose File ➡ Properties.

4 Click Send Options.

5 Select the Fax Options tab.

6 Under Cover Sheet, select First Mail Attachment. The first mail 
attachment will be transmitted as a cover sheet.

7 Click OK.

Specify a Fax Header for Microsoft Outlook (Exchange 5.5 Only)

1 Launch Outlook.

2 Choose File ➡ New ➡ Mail Message.

3 Choose File ➡ Properties.

4 Click Send Options.

5 Select the Fax Options tab.

6 Under Settings, type a Fax Header.

7 Click OK.

Specify a Call Station ID for Microsoft Outlook (Exchange 5.5 Only)

1 Launch Outlook.

2 Choose File ➡ New ➡ Mail Message.

3 Choose File ➡ Properties.

4 Click Send Options.

5 Select the Fax Options tab.

6 Under Settings, type a Local CSID.

7 Click OK.

Fax from the Microsoft Outlook Address Book

1 Launch Outlook.

2 Choose File ➡ New ➡ Mail Message.

3 Click To.

4 Use Show Names from the to select your Personal Address Book.

5 Select a recipient’s name or a fax distribution list 

6 Click To, Cc, or Bcc to transfer recipients to the Message 
Recipients list.

7 Click OK.

8 Enter the text of your fax.

A cover sheet can be included as an attachment.

You can include any other attachments. These are faxed, like the text 
entered in the message window itself.

9 Click Send.
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Fax from Microsoft Outlook

1 Launch Outlook.

2 Choose File ➡ New ➡ Mail Message.

3 In To, type the recipient's name and fax number of using the 
following syntax.

[FAX:recipient_name@fax_number]; . . .

For example: 

[FAX:J Doe@222-333-4444].

The keyword FAX, the square brackets enclosing the command, the 
name, and the fax number are mandatory. Enter additional recipients 
by separating each with semi-colons.

Alternatively, use the LightningFAX addressing format described on 
page 128.

An example would be:

fax:/fn=John/ln=Smith@5551212

Note: As shown above, the fax=fax_number syntax used with other 
gateways has no meaning when addressing recipients for the 
gateway for Microsoft Exchange, since the number goes after 
the "@".

4 Enter the text of your fax.

A cover sheet can be included as an attachment.

You can include any other attachments. These are faxed, like the text 
entered in the message window itself.

5 Click Send.

Faxing through the SMTP Gateway

E-mail products that use the gateway for SMTP include such products 
as Microsoft Outlook Express, Netscape Communicator, and Eudora. 
The following section outlines the means to manage address books and 
to send faxes. However, details may vary depending on the e-mail 
software you are using.

Add Recipients to an SMTP Mail Client

All SMTP mail clients, such as Microsoft Outlook Express and 
Netscape Messenger, include an address book in which you can store 
names, e-mail addresses, and other information. If the LightningFAX 
Gateway for SMTP is installed, you may wish to enter fax recipients in 
the address book. The following steps are generalized to apply to most 
SMTP mail clients.

1 Launch the SMTP mail client.

2 Choose the menu selection that open the address book.

3 Choose the menu selection that allows you to enter a new contact.

4 Type the recipient's name in the fields provided.
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5 In the field that normally receives the e-mail address, enter the 
recipient information using the following syntax:

fax=fax_number@domain_name

where domain_name is the domain where the email account resides.

For example: 

fax=4445555@MyCompanyDomain.com

6 Add the recipient.

Note: All SMTP mail clients allow you to maintain mailing or 
distribution lists of the contacts in an address book. The gateway 
for SMTP allows you to select a mailing list or distribution list of 
fax recipients. However, because the details of adding contacts to 
a mailing list vary depending on the mail software, Interstar can 
only direct you to the documentation provided by your SMTP mail 
software.

Fax from an SMTP Address Book

1 Launch the SMTP mail client.

2 Choose the menu selection that initiates a new message.

3 Choose the menu selection that allows selection of a contact or mailing 
list.

4 Type a title in the Subject field.

5 Type the text of the fax.

6 Add whatever attachments are to be sent.

7 Choose the menu selection that transmits the fax.

Note: The gateway for SMTP supports cover sheets through body codes. 
If LightningFAX cover sheets reside on your computer, you can 
use the cover sheet body codes. If they reside on the computer 
where the LightningFAX server resides, you can use body codes to 
specify a public profile that references a cover sheet. See About 
Body Codes on page 135 and, specifically, Cover Sheet Body Codes 
on page 138 for information. The @@Profile body code is 
described on page 136. Your system administrator should detail 
which method is available to you.

Fax from an SMTP Mail Program

1 Launch the SMTP mail program.

2 Choose the menu selection that initiates a new message.

3 Type the recipient in the To field using the following format:

fax=fax_number@domain_name

where domain_name is the domain where the email account resides.

For example:

fax=4445555@MyCompanyDomain.com
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Alternatively, if the gateway has been configured to poll the messages 
from a mailbox using the POP3 protocol, you can enter the recipient 
like this:

"fax_number"<FAX@smtp_server_name.com>

For example: 

"3335555"<FAX@centerone.com>

You can also use the XMediusFAX addressing format described on 
page 133.

An example would be:

fax=5551212/fn=John/ln=Smith/

co=MyCompany@domain.com

Note: You can enter several recipients by separating each with a 
comma or a semi-colon, depending on the mail program

4 Enter the text of the fax.

5 Add whatever attachments are to be sent. 

6 Choose the menu selection that transmits the fax.

Fax Using a Distribution List

All gateways support the use of distribution lists to fax a large number 
of recipients.

A distribution list is a comma-separated-value (.csv) file composed in 
any text editor or in Microsoft Excel.

Note: The delimiter does not necessarily have to be a comma. Any 
acceptable internationaldelimiter may be used, as long as it is 
specified in the List Separator field of the Numbers tab, in 
the Start ➡ Settings ➡ Control Panel ➡ Regional Options 
dialog.

About Distribution Lists

You can create a distribution list using any text editor such as Notepad 
or with Microsoft Excel. The .csv extension is mandatory. The file is 
arranged in columns and rows. The columns represent a category of 
information — such as first name, last name, company, address, fax 
number, etc. The rows represent the information about the recipients 
that corresponds to the category.

These are the available headings.

Address1 Country LastName User1

Address2 Email Pager User2

BillingCode Extension Phone User3

Cellular Fax Salutation User4

City FirstName State ZipCode

Company JobTitle SubBillingCode
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Creating a Distribution List

Each heading is entered as a single column on the first row. Headings 
can be specified in any order and in any combination; although Fax is 
mandatory. The value for each category used is specified on the rows 
below.

A distribution list in Excel might resemble the following.

Spaces are permitted and most categories — Fax is the exception — can 
be without entries.

Note: When using Microsoft Excel, be sure to save the spreadsheet as a 
.csv file.

The same information in a .csv text file would match the following. 
Spaces are permitted. Unfilled categories are indicated by commas.

FirstName,LastName,Company,Fax,BillingCode
Sue,Bernard,CGF Consulting,9893333,BAC12
Albert,Fellows,ABC Industries,333-2232,A 1094
Debi,Johnson,,111-3333,
David,Mark,Katon Inc.,888-0099,
Lynn,Schiller,,999-3334,7708

Faxing through a Distribution List

1 Launch your e-mail program.

2 Specify the distribution list in the To field using the following format.

distlist=filename.csv

You can also use the LightningFAX addressing format described on 
page 128.

An example would be:

distlist=clients.csv@MyFaxDomain.com

3 Include the .csv file as an attachment.

4 Compose your message.

5 Click Send.

FirstName LastName Company Fax BillingCode

Sue Bernard CGF Consulting 989-3333 BAC12ZH12

Albert Fellows ABC Industries 333-2232 A 1094990

Debi Johnson 111-3333

David Mark Katon Inc. 888-0099

Lynn Schiller 999-3333 7708102 THS
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About Body Codes

Body codes are codes you specify in the body of your message. Some 
are strictly informational, others perform an action of some kind, a 
third type specifies a cover sheet and the sender information to appear 
in it. A body code also specifies a distribution list for fax broadcasts.

Body codes are specified in the following format.

@@CODE [value]

Although most specify a value, some do not. For example, the 
@@UseLCR body code is used without a value to select Least Cost 
Routing. The @@CSID body code requires a value.

If spaces appear in the value, an address is usually composed of the 
number and the name of a street, the value is entered between 
quotation marks.

@@CODE "value value value"

If the quotation marks are omitted, only the first string is recognized 
as a value. The next strings are considered part of the actual message 
being sent.

Note: Body codes are not supported in messages in RTF or HTML 
format. If body codes are to be used, the message must be in plain 
text.

Informational Body Codes

Informational body codes write information that appears in fax details. 
When the fax details are accessed in the manager, the values specified 
appear.

Informational body codes include:

Operational Body Codes

Operational body codes perform an action of some kind. Actions can 
include specifying a priority, selecting an outgoing LightningFAX 
resource, selecting a profile, and scheduling transmission, etc.

@@APITag
@@APITag2

specifies the API tag to appear in Specific fax 
details. API tags are no more than 10 
numeric characters.

@@APITag 12343

@@CallBackNumber specifies the callback number to appear in 
Specific fax details.

@@CallBackNumber 191-8888

@@CSID specifies a call station ID to appear in Specific 
fax details. An alphanumeric value is specified.

@@CSID "ABC 123"
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Operational body codes include:

@@AlternateNotificationAddress

specifies an alternate notification email address 
than the default.

@@AlternateNotificationAddress 
email_address

@@FaxHeader specifies the alphanumeric line to appear at the 
top of a received fax. Fax headers can detail 
sender information, the company name and a 
fax number, or even a slogan.

See Chapter 13 Introducing Fax Headers for 
details.

@@FaxHeader "Sent by LightningFAX"

@@FaxPrefix specifies a number to be dialed before the fax 
number. An example of a fax prefix is a number 
dialed to obtain an outside telephone line.

@@FaxPrefix 9

@@FaxSuffix specifies a number to be dialed after the fax 
number is dialed. An example of a fax suffix is 
your PIN number.

@@FaxSuffix 9890

@@NoNotificationOnFail

specifies that no notification appear in your 
e-mail program when an outgoing transmission 
fails. There is no value to specify.

@@NoNotificationOnFail

@@NoNotificationOnSuccess

specifies that no notification appear in your 
e-mail program when an outgoing transmission 
is successful. There is no value to specify.

@@NoNotificationOnSuccess

@@Priority specifies a priority for the fax sender. Entries 
range from one, the highest, to 10, the lowest. A 
fax sent with a priority of one will be 
transmitted before a fax sent with a priority of 
three.

@@Priority 3

@@Profile specifies the profile to be used. Profiles contain 
sender information and can reference a fax 
header and cover sheet. The value specified is 
the name of the profile.

@@Profile profile_name
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@@ResourceNumber specifies an outgoing LightningFAX resource. 
You must have access to the resource in order to 
select it. By default, resources are numbered 
from 1 to 15.

@@ResourceNumber 3

@@Retries specifies the number of times an attempt to 
establish a connection should be made. Entries 
can range from zero (no retries) to 10.

@@Retries 0

@@ScheduledDate specifies the date your message is to be sent. 
This value appears in fax details. Date is 
specified in the format YYYY-MM-DD. The exact 
time of day the fax will be sent on that date is 
the time the fax is submitted.

@@ScheduleDate 2001-01-31

@@ScheduledDateTime

specifies the time your message is to be sent in 
seconds since January 1, 1970.

@@ScheduledTime specifies the time your message is to be sent. 
This value appears in fax details. Time is 
specified in the format hh.mm[:ss] in 
24-hours. Seconds are optional.

@@ScheduledTime 23:59

@@UseLCR specifies that your message is to be sent using 
Least Cost Routing. There is no value to specify.

@@UseLCR

@@UserID
@@UserPassword

specifies that the fax is to be sent on behalf of 
a LightningFAX user. You must know the 
user’s LightningFAX user ID and include the 
user’s password.

@@UserID Administrator
@@UserPassword grdn25

Note: Administrators can oblige users of an 
SMTP mail gateway to verify the right to 
send faxes using e-mail software by 
entering their LightningFAX user ID 
and password. When this is the case, the 
@@UserID and @@UserPassword codes 
must be used.
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Cover Sheet Body Codes

Cover sheet body codes let you specify a LightningFAX cover sheet and 
specify the sender information to appear in it. LightningFAX attaches 
the cover sheet automatically, placing the sender information in the 
body codes in the cover sheet. 

For example, you could use the @@Cover body code to select the cover 
sheet named Default and use the @@SenderFirstName and 
@@SenderLastName body codes to indicate your first and last name in 
the message. The fax recipient will receive your message with that 
cover sheet and your first and last name correctly listed.

Cover sheet body codes must correspond to the variables that appear in 
the cover page. That is, if you specify the @@SenderPager body code 
and use the @@Cover to include a cover sheet that does not have a 
pager variable, the code will be ignored.

Cover sheet body codes include:

@@Cover specifies a LightningFAX cover sheet to 
be sent with your message. Please note 
that the .cse extension must not be 
entered and that only cover sheets that 
reside on the server can be specified 
here.

@@Cover Basic02

@@NoCover specifies that no cover sheet be used. 
This body code might be applied when 
the @@Profile body code uses a cover 
sheet you do not wish to use. There is no 
value to specify.

@@NoCover

@@SenderDear specifies a salutation such as Ms. Mr., 
etc.

@@SenderDear Prof.

@@SenderAddress1
@@SenderAddress2

specifies the sender’s address

@@SenderAddress1 "123 Any Street"
@@SenderAddress2 "Suite 3324"

@@SenderBillingCode
@@SenderSubBillingCode

specifies your main or principal billing 
code and a detail sub-billing code. The 
first might identify your company, the 
second a department within the company

@@SenderBillingCode 123ACME56
@@SenderSubBillingCode Dept12A

@@SenderCellular specifies the sender’s cellular phone 
number

@@SenderCellular 123-545-9999



Chapter 14 Introducing LightningFAX Mail Gateways

LightningFAX User Guide 139

Distribution List Body Code

@@SenderCity specifies the sender’s city.

@@SenderCity "New York"

@@SenderCompany specifies the sender’s company.

@SenderCompany "ABC Industries"

@@SenderCountry specifies the sender’s country.

@SenderCountry "Great Britain"

@@SenderEmail specifies the sender’s e-mail address.

@@SenderEmail bjones@abc.org

@@SenderFax specifies the sender’s fax number

@@SenderFax 999-7777

@@SenderFirstName specifies the sender’s first name.

@@SenderFirstName John

@@SenderJobTitle specifies the sender’s job title.

@@SenderJobTitle Manager

@@SenderLastName specifies the sender’s last name.

@@SenderLastName Doe

@@SenderPager specifies the number of the sender’s 
pager

@@SenderPager 345333

@@SenderPhone specifies the sender’s telephone number.

@@SenderPhone 9998888

@@SenderState Specifies the sender’s state or province or 
region.

@SenderState "West Virginia"

@@SenderZipCode Specifies the sender’s zip or postal code.

@@SenderZipCode 100098-1212

@@DistritbutionList references a distribution list, which must 
be included in your message as an 
attachment. See About Distribution Lists 
on page 133 for details on composing 
distribution lists.

@@DistributionList advert01.csv
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Using Body Codes

Body codes are often used to include a few items of information that 
might otherwise be omitted.

If you use the @@Profile body code and reference a profile that 
already includes a cover sheet, you would be unlikely to also use the 
@@Cover body code and use cover sheet body codes to populate it with 
sender information. You might, on the other hand, need to use a fax 
prefix, or to schedule transmission for a later date or time.

Combining the @@DistributionList and @@ScheduledTime body 
code would allow you to fax to a large number of recipients and to 
schedule transmission for the early morning hours.

Here is an example of how body codes might be used.

@@FaxHeader "ABC Industries - ** ** - 332-455-9999"
@@DistributionList broadcast02.csv
@@Priority 1
@@ScheduledTime 01:30
@@FaxPrefix 9
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15 Introducing the Forms for
Microsoft Outlook

The forms for Microsoft Outlook let users send and receive fax 
messages in a more detailed format, through Microsoft Outlook. Aside 
from the basic fax composition form (for sending), there are forms to 
be used when receiving notifications of fax system events (Incoming 
New, Incoming Failed, Outgoing Sent, Outgoing Failed and 
Preview), and forms for creating private or public profiles.

Incoming faxes are received in your inbox and are handled exactly as 
you handle the e-mail you receive. HTML and RTF formats are 
supported.

Note: To use the forms for Microsoft Outlook with Outlook 2003 on 
Windows 2003, you need to either install the Windows 2003 
Service Pack 1 or disable "Cached Exchange Mode", in Outlook 
2003.

Fax Status

Icons distinguish the various statuses of the faxes you send and 
receive. See Incoming and Outgoing Fax Status on page 25 to learn 
what each icon means.

Note: The forms for Microsoft Outlook should not be confused with the 
gateway for Microsoft Exchange. The gateway and the forms work 
together but serve different purposes.

The gateway submits outgoing faxes, generated from mail 
messages, to the fax server, and processes mail notifcations 
triggered by the fax server.

The forms for Microsoft Outlook are simply an extended graphical 
user interface designed for the manipulation of mail messages 
sent to and received from the gateway.

The features of the forms for Microsoft Outlook include profiles, cover 
sheets, the capability of entering sender and recipient billing 
information, etc...
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Forms for Microsoft Outlook and Profiles

A profile, either public or private, is a pre-defined set of values 
designed to fill up the composition form. It saves time for the users, 
since they do no have to fill out repeatedly the same information for 
each fax they send, for instance, the company name, address and 
phone numbers; a cover sheet to include with the fax, etc...

In their default configuration, the forms for Microsoft Outlook offer 
public profiles, which are usually maintained by the administrator. A 
forms user selects either of the profiles when faxing using Outlook.

However, if a user must have private profiles as well, the administrator 
installs the Outlook Add-in on the user’s computer. That operation 
provides a folder named LFProfiles for the users private profiles.

Private profile fields form a superset of the public profiles fields, 
because they are dedicated to a single individual and thus enclose 
personnal information such as his/her name, while the latter is shared 
amongst individuals in the same organization, and thus encloses global 
information such as its address.

Installing the Outlook Add-in also adds the  button to the Outlook 
toolbar. As described below, users can then launch the fax composition 
form by making the usual menu selections or simply by clicking the 
button (if SendFAX is not installed).

Forms for Microsoft Outlook and SendFAX

Finally, power users sometimes require the still more extensive 
functionality of SendFAX, LightningFAX’s main faxing interface. 
When this is the case, an administrator installs both the Outlook 
Add-in and SendFAX on the user’s computer. Then, when the user 

clicks the  button in Outlook, SendFAX replaces the fax 
composition form. All the other forms remain accessible.

This chapter assumes that you do not have SendFAX installed. If you 
do, see Chapter 6 Introducing SendFAX for complete information on 
using that module.

Launching the Fax Composition Form

Note: When launching the Composition and profile forms, or sending 
a fax composed with them, you may get the following warning 
from Outlook:

Simply click Yes.
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1 Launch Outlook.

2 If the Outlook Add-in is installed, click the  button or choose 
Tools ➡ Create a new FAX.

If SendFAX is installed, it is launched automatically. Otherwise, the 
Composition Form is displayed in Outlook.

OR

1 Launch Outlook.

2 If the Outlook Add-in is not installed or if it is installed along with 
SendFAX, choose Tools ➡ Forms ➡ Choose Form.

Note: If necessary, you may need to select the Organizational 
Forms Library in the Look In field, first.

3 Double-click on LightningFAX Composition, or select it and click 
Open.

Note: Other forms may be displayed; you can safely ignore them.
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Managing Sender Information and Transmission Settings

Sender information includes such things as your name and job title, 
your contact numbers and email address, your company and its 
address, etc...

Sender information is applied only to the current fax. An alternative to 
repeatedly entering sender information is to create a private profile. 
Your sender information can be entered once in a profile and you 
would select that profile when you send a fax.

Using a profile does not prevent you from entering sender information 
when sending an individual fax. The information you enter in the 
Composition Form will override corresponding information in any 
profile you use.

Sender information is organized in four tabs:

Most of the fields are self-explanatory. However, some fields require 
more details:

❐ CSID represents your call station ID.

❐ Prefix represents a number to be dialed before the fax number is 
dialed; an number dialed to access an outside telephone line is an 
example.

Name Company Delivery Options Billing Codes

Salutation Email Prefix Sender Billing 
Code

First Name Phone Suffix Sender Sub 
Billing Code

Last Name Fax Retries Recipient Billing 
Code

Title Cellular Priority Recipient Sub 
Billing Code

Pager Delayed Delivery

CSID Notify on 
successful 
delivery

Callback Notify on failed 
delivery

Name Use LCR

Address

City

State/Province

Zip Code

Country
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❐ Suffix represents a number to be dialed after the fax number is 
dialed; an personal access code to permit long distance calls is an 
example.

❐ Retries represents the number of times the server retries send a 
fax, when it fails to transmit successfully (the remote fax machine 
may be busy, or does not answer). A default can be set by the 
administrator. The minimum is 0; the maximum 99.

❐ Priority indicates whose faxes have a higher or lower priority. 
Priority ranges from 1, the highest, to 10, the lowest. An 
administrator can assign a default, and you cannot enter a priority 
higher than the priority assigned by the administrator. By default, 
the priority is set at 3.

❐ Use LCR instructs the forms for Microsoft Outlook to use Least 
Cost Routing. Briefly, least cost routing is a means of sending 
faxes to a LightningFAX server near the final destination via the 
internet. The fax is then forwarded from that server to its 
destination by telephone. An administrator will inform you if least 
cost routing is available. You must select it whenever your faxes 
are to use it.

❐ For the outgoing notification forms to be used (see Outgoing Fax 
Notifications on page 155), the Notify on successful 
delivery and Notify on failed delivery boxes should be 
checked accordingly.

Adding Fax Recipients to your Personal Address Book

1 Choose Tools ➡ Address Book.

2 Select the appropriate contact list.

3 Click New.

4 Select New Contact and click OK.

5 Enter the recipient's name in the Full Name field. You can then specify 
a fax number in the Business Fax field. Alternatively, you can enter 
an e-mail address in the E-mail field.

When you send a fax to a contact with a fax number, the fax is sent to 
the recipient’s fax machine. When you send a fax to a contact with an 
e-mail address, the fax is included as an e-mail attachment and 
received in the recipient’s e-mail inbox.

Note: If you enter both a fax number and an e-mail address, Outlook 
creates a single contact entry, but presents both destinations as 
separate entries in the address book.

6 Add any additional contact information you wish.

7 Click Save and Close.

8 Close the Address Book window.
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Creating a Fax Distribution List

1 Choose Tools ➡ Address Book.

2 Select the appropriate contact list.

3 Click New.

4 Select New Distribution List and click OK.

5 Enter the name of the distribution list in the Name field.

6 Click Select Members to add existing contacts. Use Add New to add 
new contacts.

7 Click OK.

8 Click Save and Close.

9 Click OK.

Creating a Private Profile

An administrator must install the Outlook Add-in to provide you with 
private profiles. You can have more than one private profile although 
each must have a unique name. Information entered in a profile 
mirrors the sender information described above. However, the two 
notification options are not available.

1 In Outlook, display the folder list.

2 Select the LFProfiles folder.

Note: MRU is the most recently used profile. It is used by the 
composition form to remember values used previously. Users 
should not manipulate items in this folder.

3 Click New or double-click in the right-hand panel.

4 Enter the information the private profile is to contain.

5 Click Save and Close.

In the dialog for the Profile Management tab is information 
concerning the private profile itself:

Profile Name the name of the private profile;

Cover Sheet select a standard cover sheet;

Description a description of the private profile.
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In the dialog for the Name tab is personal information about the 
sender:

Salutation select a standard salutation;

First Name the first name of the sender;

Last Name the last name of the sender;

Title the title used by the sender.
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In the dialog for the Company tab is information relating the 
organization the sender is representing:

E-mail the email address of the sender;

Phone the phone number of the sender or the company;

Fax the fax number used by the sender;

Cellular the cellular phone number of the sender;

Pager the number of the paging device used by the sender;

CSID the Call Station ID of the sender;

Callback Number a phone number where the sender can be contacted;

Name the name of the organization represented by the sender;

Street the street address of the organization represented by the sender;

City the city where the organization is located;

State/Province the state or province where the organization is located;

Zip Code the zip or postal code of the organization represented by the sender;

Country the country where the organization is located;
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The dialog for the Delivery Options tab offers settings that 
determine how a fax is to be transmitted:

The dialog for the Billing Codes tab lets you specify billing code 
information for the sender, if required:

Fax Prefix a prefix to be appended before the fax message;

Fax Suffix a suffix to be appended after the fax message;

Retries the number of times to retry sending the faxes, before failure;

Priority select a priority for fax transmission;

Use Delayed 
Delivery

check this box to transmit the faxes at a specific time, entered in the 
Time (HH/MM) field;

Notify on 
successful 
delivery

check this box to receive a notification when a fax is successfully 
transmitted;

Notify on failed 
delivery

check this box to receive a notification when a fax fails to transmit;

Use LCR check this box to use least-cost routing when sending faxes.

Sender Billing 
Code

the billing code of the sender;

Sender Sub 
Billing Code

the sub-billing code of the sender.
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Faxing with Forms for Microsoft Outlook

1 In the Composition Form, click To.

2 Select a contact list and click Add to add a contact or a distribution list 
to make entries to the To or Cc fields (see Adding Fax Recipients to 
your Personal Address Book and Creating a Fax Distribution List on 
page 146 for more details).

3 Click OK.

4 You can enter a Subject, if you wish.

5 Use Profile to select a profile, if you wish only) (see Creating a 
Private Profile on page 146 for more details).

6 Use Cover Sheet to select a standard cover sheet, if you wish .

Note: A single custom cover sheet (of .cse format) can be added 
manually, by specifying it as an attachment to the fax, as shown 
in step 8. None must be selected in the Cover Sheet box, 
however.

Profiles can include a cover sheet. If the profile you selected 
includes one, using Cover Sheet will replace the cover sheet 
specified in the profile.

7 Enter the text you wish to appear on the cover sheet in the message 
window.

8 Click  to navigate to a folder and select the documents you wish to 
fax.

9 If you wish to first receive a Preview notification, before sending the 
fax, check the Preview box. The preview is emailed to your inbox, but 
the fax is not sent.

Uncheck this box, if you want to actually transmit the fax.

10 Click Send.

Note: When launching the Composition form, or sending a fax 
composed with it, you may get the following warning from 
Outlook:

Simply click Yes.
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Manual Addressing

You can also address a fax by entering an e-mail address in the To field 
or by using the following syntax to enter a fax number.

[FAX:recipient_name@fax_number] ; . . .

For example: [FAX:J Doe@111-222-3333].

You can enter more than one recipient by separating each with a 
semi-colon.

Notification Forms

There are five different notification forms: Incoming Failed, 
Incoming New, Outgoing Failed, Outgoing New and Preview.

The first four enable the gateway for Microsoft Exchange to issue 
enhanced notifications, according to the status of sent or received 
faxes, while the Preview form, as its name implies, enables it to issue 
a notification that includes a preview of an outgoing fax (when 
specified in the Composition Form).

Note: These forms are not intended for fax composition, only for 
reading, opening them in Outlook is pointless.

When opening a notification form, the content of the fax is displayed 
as a TIFF or PDF document, under the default Fax tab (see snapshot 
on next page).

Note: The PDF viewing component in Adobe Acrobat Reader 7 is only 
compatible with Microsoft Outlook 2003 or Microsoft Outlook XP 
with Service Pack 3. Using it with any older version of Outlook 
may cause the latter to crash unexpectedly.

The Subject display differs, according to the type of notification:

❐ In the case of an Incoming Failed notification, it says Fax 
had error when receiving from CSID: Pages x, where 
x is the number of pages in the fax.

❐ In the case of an Incoming New notification, it says Fax 
Received from CSID: Pages x.

❐ In the case of an Outgoing Failed notification, it says Fax 
had error when sending to recipient at 
destination, where recipient and destination are as 
specified by the user.

❐ In the case of an Outgoing Sent notification, it says Fax sent 
to recipient at destination,

❐ In the case of a Preview notification, it says: Preview of 
fax_subject, where fax_subject is as specified by the user.

There are three other tabs available: Message, Fax Status and 
Details.
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Incoming Fax Notifications

The Message tab displays the basic information you would receive, in 
the form of a notification email, from the gateway for Microsoft 
Exchange, if the forms were not installed. The values displayed in this 
example are the default settings. The content of this display can be 
modified by an administrator, by changing the appropriate notification 
template file (.wtx).
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For an Incoming New or an Incoming Failed notification, under 
the Message tab, are several display values:

An Incoming Failed notification also has the following values:

Status the status of the fax, either New or New Failed;

Message ID the ID number of the message, as attributed by the server;

Pages Received the number of pages received, as part of the fax;

Time Received the time and date at which the fax was received;

Duration the time required for transmitting the fax;

Remote CSID the Call Station ID of the sender;

Return Code the error code and message returned with the failed transmission;

Channel Number the number of the channel through which the fax was received.
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The Fax Status tab displays two sections:

In the Fax Status section are four display values:

In the Routing Details section are three display values:

Status either Fax Received or Fax had error when receiving;

Time Received the time and date at which the fax was received;

Pages Received the number of pages received, as part of the fax;

Duration the time required for transmitting the fax.

From the user who routed the fax;

To the user to whom the fax was routed;

Remote CSID the Call Station ID of the sender.



Chapter 15 Introducing the Forms for Microsoft Outlook

LightningFAX User Guide 155

Finally, under the Details tab are four display values:

Outgoing Fax Notifications

The Message tab displays the basic information you would receive, in 
the form of a notification email, from the gateway for Microsoft 
Exchange, if the forms were not installed. The values displayed in this 
example are the default settings. The content of this display can be 
modified by an administrator, by changing the appropriate notification 
template file (.wtx).

Note: The Notify on successful delivery and Notify on 
failed delivery boxes should be checked accordingly, in the 
Composition form, if you want to receive outgoing fax 
notifications.

Channel Number the number of the channel through which the fax was received;

Message ID the ID number of the message, as attributed by the server;

Error Code the error code returned with the failed transmission (0 if no error);

Description the description of the error.



Chapter 15 Introducing the Forms for Microsoft Outlook

156 LightningFAX User Guide

For an Outgoing Sent or an Outgoing Failed notification, under 
the Message tab, are several display values:

An Outgoing Failed notification also has the following values:

Status the status of the fax, either Sent or Failed;

Message ID the ID number of the message, as attributed by the server;

Time Submitted the time and date at which the fax was submitted;

Time Sent the time and date at which the transmission of the fax began;

Pages Sent the number of pages sent;

Duration the time required for transmitting the fax;

Remote CSID the Call Station ID of the sender;

Subject the subject of the fax, as specified by the user;

Fax Number the phone number of the recipient fax.

Return Code the error code and message returned with the failed transmission;

Channel Number the number of the channel through which the fax was sent.
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The Fax Status tab displays two sections:

In the Fax Status section are four display values:

In the Routing Details section are three display values:

Status either Fax Sent or Fax had error when sending;

Time Completed the time and date at which the transmission of the fax was completed;

Pages Sent the number of pages sent;

Duration the time required for transmitting the fax.

From the user who routed the fax;

To the user to whom the fax was routed;

Remote CSID the Call Station ID of the destination.
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Finally, under the Details tab are four display values:

Preview Notifications

Channel Number the number of the channel through which the fax was sent;

Message ID the ID number of the message, as attributed by the server;

Error Code the error code returned with the failed transmission (0 if no error);

Description the description of the error.
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Under the Message tab is the text This is just a preview, as 
well as three display values:

The Fax Status tab displays two sections:

In the Fax Status section are four display values:

Status always Preview;

Time the time and date at which the preview transmission was completed;

Subject the subject of the fax, as specified by the user.

Status always Fax with no status;

Time Completed the time and date at which the preview transmission was completed;

Pages Sent always empty;

Duration always 0 sec.
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In the Routing Details section are three display values:

Finally, under the Details tab are four display values:

From the sender identification;

To the recipient identification;

Remote CSID the Call Station ID of the destination.

Channel Number not applicable in a Preview notification;

Message ID not applicable; always 0(0) in a Preview notification;

Error Code the error code returned, if any (0 if no error);

Description the description of the error.
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16 Introducing the Forms for
Lotus Notes

The forms for Lotus Notes let users send fax messages in a more 
detailed format, through Lotus Notes.

Launching the Lotus Notes Client

To launch the Lotus Notes client:

1 Click Start ➡ Programs ➡ Lotus Applications ➡ Lotus Notes.

2 Log in, using your Domino account.

Opening the Fax Memo Form

There are two ways to open the form for creating a new fax:

1 Click on the Mail Fax Template on server_name icon in the 
client workspace (where server_name is the name of the Lotus Notes 
server).

2 Select Create ➡ Fax.

or

1 Double-click on the Mail Fax Template on server_name icon in 
the client workspace.

2 Under the Mail Fax Template - Fax tab that appears 
(corresponding to the Fax item in the Views selection of the left-hand 
panel), click New Fax.

A Fax Memo tab appears, under which you may enter the information 
and contents of your fax.
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Form Layout

The form layout is made-up of sender and recipient information and 
transmission setting fields, contained in a series of five tabs. Fields are 
the basic elements of data capture, storage, and display on forms.

Fields

Message Tab

Fax To: The fax number of the recipient(s);

Note: Click the button to resolve the recipient numbers.

Email To: The email address of the recipient(s);

Subject: The subject of the fax memo;

Cover Sheet: A selected cover sheet, to append to the memo.The 
default cover sheet is Basic01.

None does not append any cover sheet.

Name Tab

Salutation: A selected greeting. Available values are: Mr., Miss, 
Madam, Mister;

First Name: The sender’s first name (surname);

Last Name: The sender’s last name;

Title: The sender’s job title.
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Company Tab

Email: The sender’s email address;

Phone: The sender’s company phone number (voice);

Fax: The sender’s company fax number;

Cellular: The sender’s cellular phone number;

Pager: The sender’s pager number;

CSID: The sender’s Call-Station ID;

Callback Number: The sender’s callback number (CBN);

Name: The sender’s company name;

Address: The sender’s company address (number and 
street);

City: The city where the sender’s company is located;

State/Province: The state or province where the sender’s 
company is located;

Zip/Postal Code: The sender’s company ZIP or postal code;

Country: The country where the sender’s company is 
located.

Delivery Options Tab
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Prefix: When it is necessary to dial a number to access an 
external line, that the prefix number can be 
entered here. In most cases, the prefix is 9;

Suffix: Appears after the fax number. An example of a 
suffix is a PIN number dialed after a telephone 
number to authorize a long distance call;

Retries: Specifies the maximum number of times the 
gateway tries to transmit the fax memo, before 
failing.The maximum is 99;

Priority: Specifies the fax priority. It ranges from 1, the 
highest, to 10, the lowest;

Notify on successful delivery

Check this box to issue a notification after a fax is 
sent successfully;

Notify on failed delivery

Check this box to issue a notification if a fax is 
cannot be transmitted;

Use LCR Check this box to enable least-cost routing, if it 
has been configured;

Delayed Delivery Check this box to transmit the fax memo at a 
specific time, entered in the Time and Date 
fields.

Billing Codes Tab

Sender Billing Code: The billing code of the sender;

Sender Sub Billing Code: The sub-billing code of the sender;

Recipient Billing Code: The billing code of the recipient;

Recipient Sub Billing Code: The sub-billing code of the recipient.

Note: For more information about billing codes, see About Billing Codes 
on page 115.
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Buttons

Some buttons are also available, to execute simple actions.

Close Lets you close the fax memo without saving it.

Fax Address Lets you select recipients (individuals or groups) 
from an address book.  When one or more names 
are selected, it tries to resolve the fax numbers, as 
described in the next section.

Note: Click the button to resolve the recipient numbers again.

Email Address Similar to Fax Address, lets you select recipients 
from an address book and returns the associated 
email address.

Send Once the fax memo is completed, performs fax 
number resolution (if it hasn’t been done already) 
and transmits it.

Number Resolution

The rules for resolving the recipient fax number are as follows:

Individuals

If a recipient exists in one of the Lotus Notes address books, but does 
not have a fax number, a dialog box appears, prompting you to enter a 
number for this individual.

If a recipient exists in one of the address books and has only one fax 
number specified (either Home fax or Office fax), the resolution 
then returns this number.

If a recipient exists in one of the address books and has multiple fax 
numbers (Home fax and Office fax), a dialog box appears, 
prompting you to select which number the fax memo is to be sent to.
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Groups

The same rules as for individuals apply for groups,

Note: Lotus Notes lets you embed groups within groups, up to six levels 
deep.

Changing the Language for the Fax Memo Form

By default, the language for the fax memo form is determined by the 
Lotus Notes regional profile. To change it:

1 Select File ➡ Preferences ➡ User Preferences.

2 In the User Preferences dialog that appears, click 
International.

3 In the Regional profile box, select the desired language.

4 Exit and restart the Lotus Notes client.
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Creating and Sending a Fax

Note: If a field in any tab of the form is left empty, the equivalent setting 
defined for the LightningFAX user is used as default.See 
Managing User Properties on page 45, for more details.

1 In the fax memo form, under the Message tab, type the fax number(s) 
or the email addresses to which you want to transmit, in the Fax To 
and Email To fields.

You may also click on the Fax Address or Email Address buttons 
respectively to select recipients, by double-clicking on them in the 
Select Addresses dialog (or by clicking on them and clicking on 
the To button), and clicking OK when done..,

Note: The fax numbers selected are automatically resolved. Click the 

button to resolve your selections again.

2 Enter the subject of the fax memo in the Subject field.

3 If needed, select a cover sheet in the Cover Sheet box. The default 
cover sheet configured for the gateway for SMTP is chosen by default.

If you do not want to include a cover sheet, select None.

4 Enter the content of your fax memo, in the blank area below the line. 

Note: You may also enter or edit this at any time, under any of the 
other tabs.

5 Click on the Name tab.

6 Enter a Salutation, First Name, Last Name and Title, as 
needed.

7 Click on the Company tab.
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8 Fill the fields as needed.

9 Click on the Delivery Options tab.

10 Enter a Prefix, Suffix, Retries and Priority, as needed.

11 Check the Notify on successful delivery and/or the Notify 
on failed delivery boxes, if you want to receive notifications 
when those events occur.

12 Check the Use LCR box, to enable least-cost routing.

13 Check the Delayed delivery box, if you want the fax memo to be 
transmitted at a later time.

To set the delay, you can either type the date in the 
DD/MM/YYYY format, in the Date field, and the time 
in the HH:MM PM format, in the Time field, or by 

clicking on the  or  buttons, respectively, 
and selecting them.

14 Click on the Billing Codes tab.

15 Fill the fields as needed.

16 Click Send.
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